Merancang
p likasi Pembelajaran

Sen 5

Berbasis Android

Belajar merupakan suatu proses yang terjadi pada setiap diri orang,
dari sejak ia lahir sampai akhir hayatnya. Proses belajar dapat terjadi
kapan dan di mana saja. Ini bisa dibuktikan dengan berubahnya
tingkah laku seseorang vyang bisa terjadi pada tingkatan
pengetahuan, keterampilan, atau sikapnya. Dalam meningkatkan
pengetahuan dan keterampilan siswa dibutuhkan guru yang kreatif.
Penggunaan media pembelajaran merupakan bagian yang tidak bisa
dipisahkan dan sudah merupakan suatu integrasi terhadap metode
belajar yang dipakai. Salah satu contoh media pembelajaran yang
bisa dikonkretkan dengan memanfaatkan perkembangan teknologi
di bidang pendidikan adalah media pembelajaran berbasis android.
Dengan adanya media pembelajaran akan membuat proses pem-
belajaran lebih menarik, misalnya dari segi tampilan yang
dikombinasikan dengan beberapa gambar ataupun animasi.
Kemenarikan tampilan fisik sangat mempengaruhi proses pem-
belajaran, semakin menarik tampilan media maka siswa semakin
termotivasi untuk belajar sehingga mempengaruhi hasil belajar
siswa. Pengembangan media pembelajaran tersebut berdasar
beberapa pertimbangan: a) dapat dijadikan media belajar mandiri
bagi peserta didik, baik di sekolah maupun di luar sekolah, b) dapat
digunakan oleh pendidik sebagai media pembelajaran dalam proses
belajar mengajar.
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Media pembelajaran berbasis android merupakan salah satu media
yang sangat digemari oleh kalangan pelajar serta Praktisi Pendidikan masa
kini. Media pembelajaran berbasis android yang berkembang sangat pesat
akhir-akhir ini membawa dampak yang luar biasa pada berbagai sektor
kehidupan, katakanlah seperti bisnis ekonomi kreatif, edupreneur dan
pendidikan. Potensi pemanfaatan multimedia berbasis android dalam
pendidikan sangat banyak diantaranya adalah untuk meningkatkan
akses pendidikan, meningkatkan efisiensi, serta kualitas pembelajaran
dan pengajaran. Di samping itu, dengan kreativitas para guru, teknologi
informasi juga berpotensi untuk digunakan dalam mengajarkan berbagai
materi pembelajaran yang abstrak, dinamis, sulit, serta skill melalui
animasi dan simulasi dalam bentuk multimedia pembelajaran berbasis
android atau juga multimedia pembelajaran interaktif (MPI). Guru
dan dosen diharapkan dapat memanfaatkan teknologi informasi secara
optimal untuk memfasilitasi aktivitas pembelajaran yang inovatif. Strategi
dan metode pembelajaran yang berpusat pada peserta didik menjadi
sangat cocok guna mendorong pengembangan pengetahuan dan skill
peserta didik. Dalam dunia global ini peserta didik tidak cukup dengan
hanya mengetahui informasi dan mengingat fakta, tetapi mereka harus
bisa berpikir kritis, dan menyelesaikan permasalahan, serta memiliki skill
untuk berkomunikasi dan bekerjasama. Di samping itu, peserta didik




harus mampu beradaptasi, mempunyai inisiatif, mampu mengakses dan

menganalisis informasi serta mempunyai keingintahuan tinggi. Buku ini

akan membahas multimedia pembelajaran untuk mata pelajaran Seni

Budaya sebagai contoh berbasis android mulai dari konsep hingga praktik

pembuatan. Garis besar isi buku setiap bab adalah sebagai berikut.

Bab 1. Media pembelajaran interaktif. Dalam bab ini akan dibahas
konsep media pembelajaran, mulai dari pengertian media
pembelajaran, macam-macam media pembelajaran, manfaat
media pembelajaran, multimedia interaktif, aplikasi mobile,
dan android.

Bab2. Proses pembuatan media pembelajaran interaktif berbasis
android. Dalam bab ini akan dibahas teori yang mendasari
MPI, mulai dari praproduksi, produksi dan tahapan-tahapan
pembuatan media pembelajaran interaktif berbasis android.

Bab 3. Tahap pascaproduksi. Dalam bab ini akan membahas evaluasi
prosuk apakah media yang dibuat sesui dengan tujuan-
tujuan yang telah ditetapkan pada praproduksi yang berupa
pemahaman, aplikasi, dan analisis.

Perancangan aplikasi multimedia interaktif untuk pembelajaran
seni budaya dikemas serta disesuaikan dengan perkembangan terbaru.
Buku ini diperuntukkan bagi siapa saja yang sedang mengembangkan
media pembelajaran karena secara lengkap membahas mulai dari konsep
hingga pengembangan. Di samping itu, buku ini juga tepat sebagai acuan
bagi peneliti yang akan melakukan penelitian jenis R & D (Research and
Development) dalam bidang multimedia pembelajaran, karena model yang
dikenalkan tepat sesuai tuntutan penelitian jenis tersebut. Akhirnya
semoga buku ini bermanfaat bagi masyarakat luas, dan tentu saja penulis
terbuka menerima kritik dan saran untuk penyempurnaan buku ini.

Padang, Agustus 2020

Penulis
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A. Pengertian Media Pembelajaran

Media sangat erat kaitannya dengan proses belajar mengajar, karena
dengan adanya media dalam proses pembelajaran, mempermudah guru
dalam menyampaikan materi pelajaran dan memudahkan siswa dalam
menerima materi pelajaran yang disampaikan.

Tujuan media adalah sebagai alat komunikasi dan belajar, sehingga
konsep media adalah sebagai alat perantara dalam komunikasi dan
belajar dalam rangka menyampaikan pesan atau informasi. Dalam
proses pembelajaran, media digunakan untuk memudahkan guru dalam
menyampaikan informasi sehingga pembelajaran dapat berjalan efektif
dan efisien yaitu berupa media pembelajaran.

Media pembelajaran adalah sarana untuk meningkatkan kegiatan
proses pembelajaran. Media pembelajaran dapat berupa hardware
ataupun software yang digunakan untuk membantu proses belajar
mengajar sehingga mempermudah daya tangkap siswa dalam menerima
materi ajar (AECT dalam Sadiman, dkk., 2011). Menurut Arsyad (2014),
media pembelajaran adalah alat bantu pada proses belajar baik di dalam
maupun di luar kelas, lebih lanjut dijelaskan bahwa media pembelajaran
adalah komponen sumber belajar atau wahana fisik yang mengandung
materi intruksional di lingkungan siswa yang dapat merangsang siswa
untuk belajar.




Media pembelajaran dapat dipahami sebagai segala sesuatu yang

dapat menyampaikan informasi atau menyalurkan pesan dari suatu
sumber secara terencana, sehingga terjadi lingkungan belajar yang
kondusif di mana penerimanya dapat melakukan proses belajar secara
efisien dan efektif.

Macam-macam Media Pembelajaran

Menurut Smaldino, et al. (2014) ada enam kategori dasar media yaitu
teks, audio, video, perekayasa (manipulative), benda-benda, dan orang-
orang.

a.

2

Teks, media yang paling umum digunakan, terdiri dari karakter
alfanumerik yang mungkin ditampilkan dalam format buku, poster,
papan tulis, layar komputer, dan sebagainya.
Audio, meliputi apa saja sehingga dapat mendengar suara seseorang,
musik, suara mekanik, (menjalankan mesin mobil), kebisingan, dan
sebagainya.
Visual, juga teratur digunakan untuk meningkatkan pembelajaran
dan termasuk diagram pada layar komputer, gambar di papan tulis,
foto, grafik dalam sebuah buku, kartun, dan sebagainya.
Video, adalah visual serta media audio yang menunjukkan gerak
dan dapat disimpan pada DVD, dalam video streaming dari internet,
seperti animasi komputer, dan sebagainya.
Benda nyata dan model manipulatif tiga dimensi yang dapat
disentuh dan ditangani oleh siswa.
Orang, orang-orang sangat penting untuk belajar. Siswa belajar
dari guru, siswa lain dan orang dewasa. Menurut Seels dan Richey
dalam Arsyad (2014), media pembelajaran dikelompokkan menjadi
4 (empat) kelompok, yaitu:
a. Media hasil teknologi cetak
Teknologi cetak adalah cara untuk menghasilkan atau menyam-
paikan materi, seperti buku dan materi visual statis terutama
melalui proses pencetakan mekanis atau fotografis. Kelompok
media hasil teknologi cetak meliputi teks, grafik, foto atau
representasi fotografik dan reproduksi. Materi cetak dan visual
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merupakan dasar pengembangan dan penggunaan materi dan
pengajaran lainnya. Teknologi ini menghasilkan materi dalam
bentuk salinan tercetak.

Media hasil teknologi audiovisual

Teknologi audio-visual adalah cara menghasilkan atau menyam-
paikan materi dengan menggunakan mesin-mesin mekanis dan
elektronik untuk menyajikan pesan-pesan audio dan visual.
Penyajian melalui audio-visual bercirikan pemakaian perangkat
keras selama proses belajar, seperti mesin proyektor film, tape
recorder, dan proyektor visual.

Media hasil teknologi komputer

Teknologi berbasis komputer merupakan cara menghasilkan
atau menyampaikan materi dengan menggunakan sumber-
sumber yang berbasis mikroprosesor. Perbedaan antara media
yang dihasilkan oleh teknologi berbasis koputer dengan dua
teknologi lainnya adalah karena informasi/materi disimpan
dalam bentuk digital, bukan dalam bentuk cetakan atau
visual. Berbagai jenis aplikasi teknologi berbasis komputer
dalam pengajaran umumnya dikenal sebagai Computer Assisted
Instruction (pengajaran berbantuan komputer). Aplikasi
tersebut meliputi drills dan practice (latihan untuk membantu
siswa menguasai materi yang telah dipelajari sebelumnya),
tutorial (penyajian materi pelajaran secara bertahap), per-
mainan dan simulasi (latihan mengaplikasikan pengetahuan
dan keterampilan yang baru dipelajari).

Media hasil gabungan teknologi cetak dan komputer Teknologi
hasil gabungan adalah cara untuk menghasilkan dan menyam-
paikan materi yang menggabungkan pemakaian beberapa
bentuk media yang dikendalikan komputer.

Dari macam-macam media pembelajaran ini, menjadi perhatian
dan pertimbangan guru untuk menentukan media yang digunakan
dalam pembelajaran. Media yang tepat digunakan untuk menunjang
tercapainya tujuan pembelajaran. Media pembelajaran interaktif
berbasis android merupakan media hasil teknologi cetak komputer.

Bab 1 --- Media Pembelajaran Interaktif 3



C. Manfaat Media Pembelajaran

Media pembelajaran sebagai alat bantu siswa dalam belajar serta

merupakan sumber belajar berupa saluran pesan guru dalam

menyampaikan materi pembelajaran kepada siswanya. Tanpa bantuan
media, maka materi pembelajaran yang sulit untuk dicerna dan dipahami
oleh siswa, terutama materi pembelajaran yang rumit dan kompleks.

Dengan adanya media pembelajaran permasalahan dalam pembelajaran

dapat teratasi. Penggunaan media pembelajaran dalam proses belajar

mengajar dapat membangkitkan keinginan dan minat yang baru,
membangkitkan motivasi dan rangsangan kegiatan belajar, dan bahkan
membawa pengaruh-pengaruh psikologis terhadap siswa.

Menurut Arsyad (2014) manfaat dari media pembelajaran adalah:

1. Media pembelajaran dapat memperjelas penyajian pesan dan
informasi sehingga dapat memperlancar dan meningkatkan proses
dan hasil belajar.

2. Media pembelajaran dapat meningkatkan dan mengarahkan
perhatian anak sehingga dapat menimbulkan motivasi anak,
interaksi lebih langsung antara siswa dan lingkungannya, dan
kemungkinan siswa untuk belajar sendiri-sendiri sesuai dengan
kemampuan dan minatnya

3. Media pembelajaran dapat mengatasi keterbatasan indra, ruang
dan waktu.

Penggunaan media pembelajaran dapat membantu keefektifan
proses pembelajaran dan penyampaian pesan dan materi pembelajaran.
Selain membangkitkan motivasi dan minat siswa, media pembelajaran
juga dapat membantu siswa menigkatkan pemahaman, menyajikan
data dengan menarik dan terpercaya, memudahkan penafsiran data
dan memadatkan informasi. Sehingga media pembelajaran dapat
meningkatkan motivasi dan keinginan belajar siswa serta siswa dapat
tertarik dan lebih mudah memahami materi yang disampaikan.

Manfaat media pembelajaran dapat meningkatkan, mengarahkan,
memotivasi siswa sehingga memudahkan proses belajar dan
meningkatkan hasil belajar serta siswa mampu belajar mandiri karena
keterbatasan indra, ruang dan waktu.
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D. Multimedia Interaktif

Menurut Surjono (2017) istilah multimedia secara etimologis berasal
dari kata multi dan media. Multi berarti banyak atau jamak dan media
berarti sarana untuk menyampaikan pesan atau informasi seperti teks,
gambar, suara, video. Jadi secara bahasa istilah multimedia adalah
kombinasi banyak atau beberapa media seperti teks, gambar, suara,
video yang digunakan untuk menyampaikan pesan atau informasi.
Menurut Munir (2013), multimedia merupakan gabungan dari berbagai
media (format file) yang terdiri dari teks, gambar, grafik, suara yang
dikemas ke dalam data digital (komputerisasi), Interaktif adalah
komunikasi dua arah atau lebih dari komponen-komponen komunikasi.
Komponen komunikasi dalam multimedia interaktif adalah hubungan
antara manusia sebagai pengguna dengan komputer. Hal ini diperkuat
pendapat wena (Tegeh, Jampel, & Pudja wan, 2015) pembelajaran yang
memanfaatkan bahan ajar dengan menggunakan media komputer akan
membuat kegiatan proses belajar menjadi menarik dan menantang bagi
peserta didik.

Multimedia merupakan kombinasi banyak atau beberapa media
seperti teks, gambar, grafik, suara, video yang digunakan untuk
menyampaikan pesan atau informasi. Multimedia digunakan untuk
memudahkan siswa dalam memahami materi pembelajaran sehingga
mencapai tujuan pembelajaran serta proses pembelajaran menjadi
menarik dan menantang. Salah satu cara untuk meningkatkan
motivasi belajar siswa yaitu dengan memanfaatkan multimedia dengan
memberikan aktivitas sehingga siswa berinteraksi dengan media
yang digunakan dalam pembelajaran. Media pembelajaran interaktif
merupakan salah satu media yang berkaitan dengan pembelajaran dan
adanya hubungan timbal balik antara pengguna dengan perangkat media
sehingga memudahkan siswa untuk memahami materi pembelajaran.

E. Aplikasi Mobile (Bergerak)

Perangkat bergerak (mobile) memiliki banyak jenis dalam hal ukuran,
desain dan layout, tetapi memiliki kesamaan karakteristik yang sangat
berbeda dari sistem desktop. Karakteristik perangkat bergerak (aplikasi)
adalah program yang digunakan orang untuk melakukan sesuatu pada
sistem komputer. Kata mobile mempunyai arti bergerak atau berpindah.
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Sehingga diperoleh pengertian bahwa aplikasi bergerak merupakan
aplikasi yang dapat dijalankan walaupun pengguna berpindah dari satu
tempat ke tempat lain. Aplikasi ini dapat diakses melalui perangkat
nirkabel seperti telepon seluler dan PDA (Safaat, 2012).

Menurut Darytamo (Tamara SK, 2013) pemograman aplikasi
bergerak tidak banyak berbeda dengan pemograman konvensional pada
PC. Aspek karakteristik dari perangkat bergerak sering mempengaruhi
arsitektur dan implementasi dari aplikasi tersebut. Dalam pemograman
aplikasi bergerak berbagai aspek teknis perangkat lebih menonjol karena
memiliki banyak keterbatasan dibandingkan komputer konvensional
atau PC. Kelebihan perangkat mobile antara lain:

a. Ukuran yang kecil

Perangkat mobile memiliki ukuran yang kecil. Konsumen meng-

inginkan perangkat yang terkecil untuk kenyamanan dan mobilitas

mereka.
b. Memory yang terbatas

Perangkat mobile juga memiliki ukuran memory yang kecil, yaitu

primary (RAM) dan secondary (disk).
c. Daya proses yang terbatas

Sistem mobile tidaklah setangguh rekan mereka yaitu desktop.

Ukuran, teknologi dan biaya adalah beberapa faktor yang mem-

pengaruhi status dari sumber daya ini.
d. Mengkonsumsi daya yang rendah

Perangkat mobile menghabiskan sedikit daya dibandingkan dengan

mesin desktop. Perangkat ini harus menghemat daya karena mereka

berjalan pada keadaan di mana daya yang disediakan dibatasi oleh
baterai.
e. Kuat dan dapat diandalkan

Karena perangkat mobile selalu dibawa kemana saja, mereka harus

cukup kuat untuk menghadapi benturan-benturan, gerakan dan

sesekali tetesan-tetesan air.
f.  Konektivitas yang terbatas

Perangkat mobile memiliki bandwidth rendah, beberapa dari mereka

bahkan tidak tersambung. Kebanyakan dari mereka menggunakan

koneksi wireless.
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g. Masa hidup yang pendek

Perangkat-perangkat konsumen ini menyala dalam hitungan detik,
kebanyakan dari mereka selalu menyala. Coba ambil kasus sebuah
handphone, mereka booting dalam hitungan detik dan kebanyakan
orang tidak mematikan handphone mereka bahkan ketika malam
hari. Salah satu perangkat mobile yang digunakan adalah handphone
versi smartphone yang telah difasilitasi sistem operasi android.

F. Android
1. Pengertian Android

Menurut Safaat (2012) android adalah sistem operasi untuk telepon
selular yang berbasis Linux. Android menyediakan platform terbuka
bagi para pengembang untuk menciptakan aplikasi mereka sendiri dan
untuk digunakan oleh berbagai macam piranti bergerak (mobile device).
Android dirancang khusus untuk perangkat-perangkat mobile layar
sentuh (smartphone dan tablet). Telah banyak aplikasi-aplikasi android
yang tersedia dalam Google PlayStore atau Play Store untuk pembelajaran.
Sehingga android sangat menunjang pembelajaran dengan berbagai fitur
yang tersedia. Fitur-fitur yang tersedia pada android sangat bermanfaat
bagi siswa untuk memahami materi pembelajaran melalui media,
sehingga guru tidak harus menjelaskan materi pembelajaran secara
berulang-ulang.

2. Keunggulan Smartphone Android

Menurut Amperiyanto (2017) sebagai perangkat yang canggih, android
mempunyai beberapa keunggulan yang patut dipertimbangkan antara
lain sebagai berikut:
1. Dukungan Produsen Hardware
Saat ini smartphone android populer, hal ini tak lepas dari dukungan
produsen hardware.
2. Harga yang Bersahabat dan Rasional
Pada umumnya harga smartphone android sesuai dengan kualitasnya,
semakin tinggi kualitasnya maka harganya semakin tinggi. Sehingga
smartphone sangat terjangkau untuk dimiliki oleh semua kalangan.
Terutama kalangan pelajar. Smartphone android bukan lagi merupakan
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barang mewah namun sudah menjadi kebutuhan. Banyak informasi
yang diperoleh melalui smartphone berbasis internet.

Memiliki Banyak Varian

Produsen smartphone android sangatlah beragam. Mulai dari merek
yang sekarang sudah menjamur. Tidak semua smartphone android
menyediakan kualitas yang bagus. Sehingga untuk memiliki
smartphone, sesuaikan dengan kebutuhan.

Luwes dan Menyenangkan

Android bersifat open source sehingga dapat mengubah tampilan
secara total namun semua terganti dari kapasitas dan prosesor
dari smartphone itu sendiri. sebagai sebuah media edutainment, suatu
media yang menggabungkan unsur edukasi (education) dengan
hiburan (enterainment) atau belajar sambil bermain.

Membuat Cerdas dan Cermat

Pada smartphone android ada pengaturan untuk mengembalikan
kepada pengaturan pabrik jika smartphone tersebut mengalami
kerusakan. Sehingga menghemat biaya untuk melakukan service
melalui toko smartphone dan memberikan manfaat yang luar biasa.
Praktis dan Banyak Aplikasi Tersedia

Aplikasi yang tersedia sangat banyak sehingga bisa disesuaikan
dengan kebutuhan. Smartphone akan semakin bermanfaat jika
mampu digunakan untuk pembelajaran karena mudah dibawa
kemana-mana. Dapat membuka materi pembelajaran ketika
berada di luar sekolah sehingga bisa belajar kapanpun dan di mana
pun, mudah untuk dibawa ke mana-mana karena terinstal dalam
telepon seluler yang notabenenya adalah alat komunikasi sehari-
hari, mudah karena yang diperlukan untuk menjalankannya hanya
sebuah telepon genggam (handphone), efisien dalam penggunaannya,
karena tidak menghabiskan banyak waktu.

Smartphone dapat menjadi media pembelajaran yang menarik

karena siswa dapat mempelajari materi pembelajaran dengan cara yang
berbeda, yaitu memanfaatkan handphone dalam pembelajaran. Sehingga
dapat disimpulkan juga bahwa media pembelajaran interaktif berbasis
android sangat cocok dijadikan salah satu media untuk pembelajaran.
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Sebelum merancang produk media pembelajaran, terlebih dahulu
kita harus memperhatikan tahapan-tahapan proses produksi produk
agar produk media pembelajaran interaktif (MPI) berbasis android yang
dihasilkan lebih berkualitas dan runut (memiliki urutan yang baik)
sehingga waktu pembuatan lebih efektif dan efisien. Ada baiknya dalam
proses pembuatan MPI ini kita membuat deskripsi kerja (job description)
yang menjadi target kita agar MPI yang kita rancang tercapai sesuai
dengan waktu yang telah kita tetapkan. Contoh job description (deskripsi
kerja) seperti gambar di bawah ini:

Gambar 1. Job Description Pembuatan MPI

Pada proses produksi MPI, ada tiga tahap yang dapat kita laksanakan
yaitu tahap praproduksi, produksi dan pascaproduksi.




A.

Tahap Praproduksi

Pada tahap praproduksi pembuatan MPI harus memperhatikan
komponen-komponen yang harus diperhatikan antara lain:

1.

Tahap Persiapan

Analisis Kebutuhan

Analisis kebutuhan yang berkaitan dengan MPI yang akan kita rancang
antara lain:

1)

2)
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Menganalisis Karakteristik peserta didik

Karakteristik peserta didik sangat diperhatikan sehingga MPI yang
dibuat menarik, memberikan motivasi siswa untuk belajar sehingga
pembelajaran bermakna dan menyenangkan (Meaningful and joyful
Learning). Karakteristik ini berkaitan dengan jenjang Pendidikan
peserta didik. Tentunya rancangan MPI akan berbeda tergantung
siapakah pengguna media pembelajaran interaktif ini. Jika anak TK
pastinya dirancang gambar-gambar kartun dengan pewarnaan yang
menarik simpatik anak-anak TK, akan berbeda jika penggunanya
adalah siswa Sekolah Menengah Pertama.

Selain karakteristik peserta didik, perhatikan juga gaya belajar
siswa. Ada 3 (tiga) gaya belajar yang sering digunakan dalam
pembelajaran yaitu visual, auditori dan kinestetik sehingga MPI
yang dibuat mampu mewakili ketiga gaya belajar tersebut. Karena
MPI harus memiliki 6 komponen utama dalam perancangannya
yaitu teks, gambar/grafik, audio, video, animasi dan interaktif.
MPI harus bersifat interaktif sehingga terjadi komunikasi dua
arah, antara pengguna dengan perangkat MPI (smartphone). MPI
membantu peserta didik dalam proses pembelajaran di dalam kelas
dan dapat belajar di mana saja dan kapan saja jika berada di luar
kelas.

Analisis Materi Pembelajaran

Memilih materi pembelajaran perlu dilakukan analisis materi
terlebih dahulu, untuk mengetahui apakah materi pembelajaran
tersebut layak menggunakan MPI untuk memudahkan siswa
belajar. Contoh pada buku ini dalah Mata Pelajaran Seni Budaya
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3)

4)

5)

6)

Pada Kelas VII SMP pada materi memainkan alat musik sederhana
yang mencakup aspek kognitif dan psikomotorik.

Menentukan Tujuan Pembelajaran

Setelah materi pembelajaran telah kita tentukan selanjutnya
menyiapkan tujuan pembelajaran pada kompetensi dasar yang akan
dijabarkan pada MPI karena tujuan pembelajaran harus diketahui
peserta didik sehingga arahan pembelajaran sesuai dengan tujuan
pembelajaran.

Pengumpulan informasi

Mengumpulkan sumber belajar yang berkaitan dengan materi
pembelajaran tersebut serta memilah manakah materi yang sesuai
dengan silabus.

Menganalisis soal-soal latihan

Pada MPI untuk melihat umpan balik dalam pembelajaran perlu
adanya soal-soal latihan yang berkaitan dengan materi pembelajaran
yang telah dipelajari pada MPI tersebut.

Menentukan jenis MPI

Jenis MPI yang kita rancang nantinya apakah bersifat offline, semi
offline online ataukah online. Pada buku ini kita akan mempelajari
rancangan MPI yang bersifat semi offline online, di mana ada
beberapa menu yang dapat langsung dioperasikan tanpa akses
internet, dan ada menu online yang membutuhkan akses internet.

Merancang draft tampilan materi pembelajaran Seni budaya sesuai
dengan perkembangan dan karakter siswa Sekolah Menengah
Pertama.

Merancang flowchart dan storyboard MPI

Flowchart adalah bagan alir yang menggambarkan urutan kegiatan
atau proses secara rinci dan hubungan antar kegiatan atau proses
dengan proses lainnya dalam suatu program yang dijabarkan dalam
bentuk simbol-simbol.

Storyboard adalah papan cerita yang disusun secara berurutan sesuai

dengan flowchart untuk memudahkan pembuatan MPL
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2. Tahap Desain (Perancangan)

Setelah melakukan analisis kebutuhan, kita masuk pada tahap desain
(perancangan). Perancangan ini berkaitan dengan rancangan dari isi
MPI antara lain:

1.

12

Halaman Utama (Home)

Halaman utama merupakan halaman awal yang berisikan informasi
isi dari media pembelajaran interaktif berbasis android yang
dikembangkan. Pada halaman utama terdapat 6 menu navigasi
yaitu 1) Petunjuk penggunaan media, 2) Kompetensi dasar, 3)
Materi Pembelajaran, 4) Soal Latihan, 5) Referensi, dan 6) Profil
pengembang.

Halaman Petunjuk Penggunaan

Halaman petunjuk penggunaan berisikan petunjuk berupa
informasi dalam bentuk ikon-ikon dan teks yang ada pada media
tersebut mulai dari icon home hingga icon exit MPL

Halaman Kompetensi Dasar (KD)

Halaman Kompetensi Dasar (KD) berisikan beberapa kompetensi
dasar yang akan kita pelajari pada media tersebut. Contoh yang
kita gunakan dalam MPI ini ada 1 kompetensi dasar yang cukup
mewakili produk MPI yang akan kita rancang.

Halaman Materi Pembelajaran

Halaman materi pembelajaran yang berisikan 1 Kompetensi
Dasar yang telah disesuaikan dengan Kurikulum 2013 Revisi
2018 beserta video tutorial beberapa materi pembelajaran yang
membutuhkan video pembelajaran. Bahan ajar bentuk video tutorial
berisikan video pembelajaran tentang materi pembelajaran aspek
psikomotorik. Video tutorial akan menyajikan secara lengkap dan
sistematis untuk memudahkan siswa dalam memahami serta
mempraktekan materi pembelajaran tersebut dengan mudah.

Halaman Soal Latihan

Halaman soal latihan berisikan 10 pertanyaan dengan 5 pilihan
jawaban, setelah mengerjakan soal latihan langsung disajikan
informasi skor jawaban serta koreksi jawaban setiap butir
pertanyaan.
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Halaman Referensi

Halaman Referensi berisikan informasi tentang daftar pustaka
yang menjadi daftar rujukan materi pembelajaran, modul yang
berisikan semua materi pembelajaran baik aspek kognitif maupun
aspek psikomotorik, evaluasi online yang berisikan soal-soal dari
semua materi pembelajaran. Pembuatan Evaluasi online dapat
menggunakan fasilitas dari google melalui google form.
Modul/e-book yang berisikan materi pembelajaran aspek kognitif dan
psikomotorik sebagai bahan ajar yang dapat diunduh oleh siswa.

Evaluasi Online

Evaluasi Online berisikan 20 pertanyaan dengan 5 pilihan jawaban,
setelah menjawab Evaluasi, lembar kerja siswa langsung tersimpan
di e-mail guru. Untuk melihat skor evaluasi secara keseluruhan
dapat di lihat langsung oleh siswa.

Setelah kita menentukan komponen-komponen yang akan kita

rancang pada MP], maka kita dapat tuangkan dalam bentuk Flowchart
dan storyboard. Contoh flowchart yang kita sesuaikan dengan materi
pembelajaran yang kita tentukan pada analisis materi sebagai berikut:

Mulai

v

1. Petunjuk

6. Profil

®

Gambar 2. Contoh Flowchart Rancangan MP!
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Flowchart telah kita rancang, selanjutnya kita merancang storyboard.
Contoh storyboard seperti gambar di bawah ini:

Keterangan Teks

Halaman pembuka berisi mengenai
Media Pembelajaran Interaktif (MPI)

berupa:
-
Judul Materi

“Seni Budaya Kelas 7 Sekolah Menengah
Pertama”

Judul Materi Nama Pengembang:
Irdhan Epria Darma Putra, M.Pd.

Gambar Background

Keterangan Gambar dan Audio

Rl Gl Audio: Audio tombol

Keterangan Navigasi

Tombol 1: Untuk memulai

menjalankan MP|

Gambar 3. Contoh Storyboard Rancangan MP|

Komponen MPI terdiri dari dua aspek yaitu aspek tampilan dan
aspek pemograman. Aspek tampilan terdiri dari desain tampilan
(layout), teks, gambar (image), audio, video, animasi dan kemasan.
Aspek pemrograman memperhatikan penggunaan navigasi dan
interactive link.

1. Aspek Tampilan

a) Desain tampilan (layout)

Desain tampilan dalam MPI yang dibuat dengan memperhatikan
prinsip-prinsip desain grafis yaitu keseimbangan, keselarasan,
kesatuan bentuk, kontras, penekanan dan pengulangan. Warna
yang dipilih bervariasi dengan dominasi biru dan putih pada
tampilan agar terlihat lebih menarik.

b) Teks

Menurut Arsyad (2014) font dengan ukuran huruf yang normal
dan tidak memenuhi layar (padat) merupakan prinsip dari
pengembangan media.
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d)

g

Jenis huruf yang dipilih dalam MPI pada materi pembelajaran
ini dapat bervariasi antara lain adalah MADEFlorence Sans
dengan ukuran 8.8 pt sampai 10 pt pada judul materi back-
ground setiap materi pembelajaran.

Gambar (Image)

Penggunaan gambar pada MPI untuk mendukung tampilan
latar belakang (background), materi dan menarik perhatian
siswa. Langkah awal dalam menentukan gambar adalah
dengan memilih gambar yang sesuai dan mendukung materi.
Gambar yang diunduh dari internet diberikan perubahan dan
penyesuaian dengan menggunakan aplikasi adobe photoshop
CS6. Ukuran gambar disesuaikan dengan ketersediaan ruang
dan banyaknya materi yang akan disampaikan gambar yang
digunakan harus memperhatikan prinsip keseimbangan
sehingga tidak mendominasi antara teks dengan gambar.

Audio

Audio MPI terdapat pada latar suara tombol, animasi dan
video serta audio rekaman penjelasan materi pembelajaran.
Latar suara tombol dan animasi bertujuan untuk menciptakan
suasana yang semangat. Audio pada video dan materi berfungsi
untuk menjelaskan informasi.

Video

Terdapat beberapa video tutorial.

Animasi

Animasi tombol pada MPI dibuat untuk memberikan perubahan
warna dan ukuran tombol.

Kemasan

MPI yang kita rancang merupakan aplikasi software berbasis
android dalam format apk, namun dapat disimpan dalam CD
(Compact Disc), USB Disc, maupun alat penyimpanan data
lainnya dalam format swf, membuka file dengan bantuan
software penunjang yaitu Animate player. Media ini juga
dapat disimpan dalam memori atau harddisk komputer. Media
ini dapat disimpan dalam waktu lama dan mudah untuk
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disebarluaskan melalui alat pemindah data maupun internet
melalui google drive/cloud drive/playstore/onecloud.

2. Aspek pemograman

a.

Navigasi/Link

Navigasi/link adalah urutan atau alur dari informasi pada
MPI yang akan kita rancang, sehingga dengan menggunakan
navigasi yang tepat, arah informasi yang kita sampaikan lebih
jelas. Pada MPI ada beberapa navigasi yang akan kita gunakan
untuk menghubungkan bagian menu utama menuju bagian isi
dari bagian menu utama tersebut.

Interactive Link

Prinsip MPI adalah menyajikan konten yang terdiri dari teks,
gambar, animasi, video, audio dan interaktif. Interaktif yaitu
adanya respons atau tindakan pengguna dalam menggunakan
MPI, bukan sekadar mengklik-klik tombol saja namun adanya
reaksi terhadap materi pembelajaran yang dipelajari melalui
soal Latihan, Evaluasi online ataupun forum diskusi. Sehingga
terjadi interaksi antara pengguna dengan media, pengguna
dengan pengguna lainnya.

B. Tahap Produksi
1. Kebutuhan Sistem dalam Mengoperasikan Aplikasi

Aplikasi yang kita gunakan untuk membuat MPI antara lain Adobe
Photoshop CS6, Adobe Animate 2015, Adobe Premiere CS6/Filmora
Studio (optional). Adobe Premiere/Filmora Studio digunakan untuk
pengolahan video (kita membuat video sendiri). Perangkat komputer
yang dibutuhkan untuk menjalankan aplikasi ini sebagai berikut:

a.
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Sistem operasi

Sistem operasi yang standar digunakan adalah Linux, Mac
Os X, Microsoft Windows. Umumnya pada dunia Pendidikan
menggunakan Microsoft Windows.

Spesifikasi Minimal Perangkat Keras (Hardware)

Personal Computer (PC)/Laptop, Processor Intel Pentium 4 3.2Ghz,
resolusi monitor 1024x768 px, RAM 2GB, Kapasitas Harddisk
250GB, DVDROM Dirive.
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C.

Aplikasi Pendukung

Aplikasi pendukung yang digunakan untuk menjalankan video
atau animasi dalam format penyimpanan 3gp, AVI atau MP4,
kita dapat menggunakan aplikasi Quicktime 7.6.6, sedangkan
DirextX 9 digunakan untuk menghubungkan program yang kita
gunakan dengan perangkat keras komputer dan JavaTM Runtime
Environment 1.6 digunakan untuk menjalankan file-file dari hasil
kompilasi aplikasi yang kita gunakan.

Menginstal aplikasi Adobe Photoshop, Adobe Animate 2015
dan Adobe Premiere atau Filmora Studio

Aplikasi Adobe Photoshop dan Adobe Premiere dapat kita install jika
memiliki CD Adobe Master Collection CS6. Pada saat menginstal, kita
dapat memilih aplikasi mana sajakah yang akan kita gunakan untuk
merancang MPI, dalam hal ini ada dua aplikasi yaitu adobe photoshop
dan premiere CS6. Jika tidak memiliki aplikasi Adobe Master Collection
CS6, dapat juga menginstal satu persatu aplikasi. Secara umum
Langkah-langkah menginstal aplikasi tersebut sama. Langkah-langkah
instalasi aplikasi:

1)

2)
3)
4)

5)
6)

7)

8)

Masukan DVD installer Adobe Master Collection CS6 original pada
komputer/laptop. Masuk ke Windows Explorer, Buka File Adobe
Master Collection CS6, Klik dua kali pada Set-up

Setelah itu akan muncul tampilan Adobe Installer.
Pilih install.

Selanjutnya Perhatikan gambar adobe software license agreement,
klik accept.

Muncul kotak dialog serial number sebagai berikut:

Serial Number telah disediakan pada folder Adobe Collection, isi
serial number, klik next.

Muncul kotak options, ceklis software Adobe Photoshop CS6 dan
Adobe Premiere CS6, dan Animate player. Setelah itu klik Install.

Tunggu hingga proses penginstalan selesai.

Proses penginstalan Adobe Master Collection CS6 menggunakan

waktu yang cukup lama, tergantung pada jumlah aplikasi adobe yang
diceklis serta spesifikasi PC/Laptop yang digunakan.
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Selanjutnya kita dapat menginstal animate 2015 (untuk windows
7, 8 dan 10).

Pembuatan Media Pembelajaran Berbasis Android

Tahap selanjutnya adalah tahap merancang produk MPI berbasis
android. Memahami software Adobe Animate, Adobe Photoshop CS6, Adobe
Premiere CS6 dan Form Google Doc tidak terlalu rumit. Mengenal dasar-
dasarnya terlebih dahulu. Menjelaskan secara umum dasar-dasar untuk
mengoperasikan Adobe Animate, Adobe Photoshop CS6 dan Form Google Doc
yang berkaitan dengan perancangan MPI berbasis android.

3. Mengedit Background Menggunakan Adobe Photoshop CS6
a. Adobe Photoshop CS6

Adobe Photoshop adalah aplikasi pengolah gambar/piksel, yang
digunakan untuk editing foto, foto kolase, brosur, pamflet dan keperluan
lainnya yang berkaitan dengan pengolahan gambar. Satuan ukuran yang
digunakan adalah piksel yang memiliki kerapatan dan warna tertentu.
Sehinga semakin besar kapasitas piksel maka semakin rapat dan warna
semakin jelas. Piksel disingkat dengan px.

Kita tidak mengupas tuntas tentang Adobe Photoshop secara
konsep atau penjelasan karena kita hanya menggunakan Adobe
Photoshop untuk mengedit foto/gambar yang akan kita gunakan sebagai
background pada MPI yang kita rancang, teks dan tombol akan kita
rancang pada Adobe Animate.

Pada aplikasi Adobe Photoshop, kita hanya gunakan beberapa tool
saja untuk mendesain background sederhana antara lain move tool, crop
tool, rectangle marquee tool, rectangle tool dan text tool saja serta memberikan
pencahayaan dan efek yang sesuai dengan background.

b. Mempersiapkan Gambar

Sebelum kita mengedit gambar untuk background, siapkan gambar-
gambar atau foto-foto terlebih dahulu. Gambar-gambar tersebut dapat
kita cari di situs-situs free download seperti freepik dan sejenisnya
agar tidak terkena copyright. Pilih background berbentuk jpg ataupun
png. Apabila kita telah mahir menggunakan Adobe Photoshop dapat
mendesain sendiri background sesuai dengan tema dari MPI yang kita
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rancang. Minimal background yang akan kita gunakan ada 12 antara
lain: Intro(pembuka), Home, Menu Utama, Petunjuk Penggunaan,
KIKD, Cover Materi Pembelajaran, Isi Materi Pembelajaran, Isi Materi
Pembelajaran lanjutan, soal Latihan, Skor Penilaian, referensi, dan
Video materi.

c. Bekerja dengan Layer

Gambar-gambar telah kita siapkan, selanjutnya mengedit background
menggunakan Adobe Photoshop dengan Langkah-langkah sebagai
berikut:

1) Buka Aplikasi Adobe Photoshop CS6.

2) Pilih Menu File —> New (membuka lembar kerja baru)

3) Seting ukuran kertas, pada kolom preset pilih custom — ketik width
dan height.

MPI berbasis android menggunakan Adobe Animate, standar
ukuran yang digunakan adalah 480pxX800px (Width/lebar 480
pikselxheight/tinggi 800 piksel), dengan resolusi 150 pixels/inch,
color mode RGB Color 8 bit. Background color yang kita gunakan
putih, pilih white. Setelah selesai tekan OK. Tampil gambar berikut:

Gambar 4. Menyiapkan File Baru

4) Kemudian file disimpan, Pilih File — Pilih Save As atau tekan
tombol shift+ctrl+s pada keyboard. Beri nama file contohnya
intro, kemudian simpan file pada folder MPI untuk memudahkan

kita dalam pencarian data selanjutnya.
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Satu lembar kerja kosong yang akan kita isi dengan background

telah siap. Selanjutnya kita akan mengambil bagian dari gambar-gambar
yang telah kita siapkan.

d.
I

20

Mendesain Background

Membuka file gambar yang telah kita siapkan, pilih menu File -
Open File - Browse di mana file gambar disimpan - Open. Akan
tampil gambar yang telah kita pilih.

Pilih gambar yang akan kita edit, Klik Open, maka terdapat satu
file pada layar seperti gambar berikut:

Lembar Kerja

Gambar 5. Tampilan Layer Adobe Photoshop C56

Sebelum kita merancang lebih lanjut, kita akan mengenal
secara singkat terlebih dahulu bagaimana bekerja dengan adobe
photoshop. Pada adobe photoshop kita akan menggunakan layer
sebagai tempat untuk menampilkan semua yang akan kita kerjakan
baik berupa gambar, teks, efek, pewarnaan dan sebagainya
Selanjutnya kita akan memindahkan gambar yang telah kita
sediakan pada layar file yang telah kita buat dengan ukuran android.
Pilih Menu File -> Place -> Pilih gambar yang akan kita tempatkan
pada background -> Klik Place dan atur ukuran sesuai dengan
ukuran background seperti gambar berikut:
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Gambar 6. Menempatkan Gambar pada Background

Selanjutnya kita akan menambahkan teks pada gambar yang telah
kita siapkan. Pada samping kanan layar.

Pilih tanda T (text) drag menuju gambar yang telah kita siapkan
pada layer], atur Font style, Font Size dan Font Color sebelum kita
mengetik pada layar seperti gambar berikut:

Gambar 7. Menambahkan Teks pada Background

Selanjutnya kita akan mengedit teks, Klik teks atau tekan tombol
T maka akan aktif font style dan lain-lainnya yang terletak diatas
file.
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10.

11
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Jika kita mau memberikan efek pada teks, dapat kita lakukan dengan
cara: Klik terlebih dahulu teks yang akan kita beri efek, jangan
lupa untuk mengecek layer untuk melihat apakah kita sedang
mengaktifkan teks yang akan kita berikan efek.

Selalu menggunakan move tool yang ada di toolbox untuk
mengembalikan posisi cursor. Selanjutnya pilih menu Layer - Pilih
layer Style, maka akan tampil gambar berikut:

Gambar 8. Memberikan Efek pada Teks

Silahkan untuk mencoba menggunakan layer style, jika untuk
mengembalikan pada tampilan semula dapat dengan cara tekan
tombol ctrl+all+z atau membuka history, Pilih menu Windows -
Pilih History klik bagian awal history.

Apabila pencahayaan background terlalu gelap atau terlalu terang,
kita dapat memberikan pencahayaan yang cukup yaitu tekan tombol
ctrl+M pada keyboard, akan tampil Curves, garis diagonal dapat
kita drag ke arah yang kita anggap cocok untuk pencahayaannya,
misalnya dari tengah ke atas akan memberikan cahaya terang pada
background dan sebaliknya. Apabila telah sesuai, klik OK.

Jika ingin diberikan variasi agar terlihat penekanan pada tulisan
dapat kita tambahkan foreground (bagian depan dari background)
dengan kotak segi empat yang dihiasi garis-garis agar tampilan MPI
semakin menarik.
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e.

Menambahkan Teks pada Background

Selanjutnya kita akan menambahkan teks pada background yang lain
dengan langkah-langkah sebagai berikut:

L.
2.

Klik Tools Text, Pilih Font Style, Font Size, Font Color

Posisikan teks 1/3 bagian atas background, ketik judul materi
pembelajaran yang akan kita tampilkan pada MPI yang kita rancang.
Contohnya: Seni Budaya.

Kita dapat mengatur tulisan dengan klik kembali tool text,
kemudian klik pada teks yang telah kita buat, selanjutnya dapat
kita lakukan mengubah font sesuai selera.

Kita dapat memberikan efek tulisan dengan Langkah-langkah

sebagai berikut:

1.

Blok teks yang akan kita berikan efek, Klik Menu Layer - Pilih Layer
Style - Pilih Blending Options — akan tampil styles dari efek-efek.

Pada teks ini hanya menggunakan efek stroke, pilih stoke - atur
size dan opacity -klik OK.

Jika efek yang kita berikan tidak menarik, dapat kita batalkan
(undo) dengan tekan tombol ctrl + z pada keyboard, jika ingin
membatalkan beberapa Langkah sebelumnya dapat dengan tekan
tombol ctrl+alt+z, dapat juga kita batalkan dari menu history yaitu
Pilih menu Window - Pilih History — akan tampil Langkah-langkah
yang telah kita lakukan.

Gambar 9. Tampilan Background
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f. Menyimpan File Background

Teks telah selesai kita buat, selanjutnya kita akan menyimpan file

tersebut dengan Langkah-langkah sebagai berikut:

1. File - Save As - Pilih Folder penyimpanan data MPI — beri nama
file - Format Jpeg atau PNG

2. Klik Save, jika memilih PNG, akan tampil PNG Option untuk
compression klik none, Interlace klik none — Klik OK.

3. File telah tersimpan. Selanjutnya untuk membuat background yang
lain dapat dilakukan dengan Langkah kerja yang sama seperti diatas.

Selain background, kita juga menyiapkan tombol-tombol (button)
yang berbentuk image/gambar yang akan kita gunakan pada MPI yang
kita rancang antara lain:

1) home, 2) petunjuk, 3) KD, 4) Materi Pembelajaran, 5) Soal

Latihan, 6) Referensi, 7) Profil, 8) Modul Online, 9) Evaluasi

Online, 10) Video Tutorial, 11) Forum Diskusi, 12) Back, 13) Next,

14) Ya, dan 15) Tidak.

Mendesain menggunakan photoshop lebih memudahkan kita
Ketika menggunakan tombol image tersebut pada timeline animate.

5. Mengenal Form Google Docs

Form google doc merupakan platform google yang digunakan untuk
membuat soal Latihan berupa pertanyaan atau kuisioner, formulir
pendaftaran online suatu kegiatan, formulir data polling pendapat
online, dan sebagainya. Form google docs merupakan fasilitas gratis
dari google. Pada saat ini, pemanfaatan google form dalam dunia
Pendidikan diminati karena dapat digunakan untuk ujian berbasis
computer (Computer Based Test/CBT). Google forms telah dilengkapi
oleh add-ons untuk memaksimalkan penggunaan form pada ujian
online, telah disediakan password/token. Kelebihan Form google
digunakan sebagai ujian online adalah kita dapat menganalisis tingkat
kesulitan butir soal yang kita sajikan karena kita dapat menambahkan
kunci jawaban serta skor nilai pada form tersebut. Analisis tersebut
berbentuk grafik. Selain itu, kita dapat membatasi waktu pengerjaan
soal. Data yang kita perlukan untuk diisi pada form google doc
akan tersimpan pada e-mail yang telah kita setting sebelumnya dan
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tersimpan dalam bentuk spreadsheet sehingga memudahkan kita
untuk melihat data yang masuk. Siapkan soal-soal yang akan kita
masukan ke form google docs, dapat berupa teks, gambar, audio,
video ataupun animasi.

Syarat menggunakan form google docs adalah kita harus
memiliki e-mail yang merupakan bagian dari google yaitu gmail
dan terkoneksi akses internet. Jika belum memiliki email gmail.
Kita harus membuat akun gmailnya terlebih dahulu. Namun
melihat kecanggihan teknologi saat ini, sudah banyak orang yang
menggunakan gmail, jadi pada bahasan ini kita tidak membahas
bagaimana cara membuat akun gmail.

Turrgusin galiry

Faiortiesand

[ L ] e repims 1 T g
e

e o o T L ey e ot e Ly

Gambar 10. Tampilan Form Google Docs

Ada beberapa jenis form pada form google docs antara lain:
a) Form yang digunakan dalam Pendidikan (Education)

1. Blank Quiz digunakan untuk membuat kuisioner/soal Latihan/
soal ujian, semua form yang berkaitan dengan pilihan pilihan
ganda (multiple choice) /ceklis (checkboxes)/memilih salah satu
pilihan (dropdown)

2. Exit Ticket digunakan untuk mengisi data informasi kuisioner
berupa data pribadi yaitu nama, alamat email, isian yang
berkaitan dengan apa yang ditanyakan pada kuisioner tersebut.

3. Assessment digunakan untuk lembar penilaian yang berisikan
penilaian kita terhadap sesuatu yang diperlukan oleh tim
penilai.
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Worksheet digunakan sebagai lembar kerja yang mirip dengan
assessment.

Course Evaluation digunakan untuk evaluasi pelatihan yang
ditujukan pada bagaimana cara penyampaian dari narasumber/
guru selama kegiatan atau mengajar.

b) Form yang berkaitan dengan Data Pribadi (Personal)

c)

26

1.

Contact Information digunakan untuk mengisi data pribadi
berupa nama, email, alamat, nomor telepon, komentar dan
lain-lainnya yang berkaitan dengan data pribadi.

Find a time digunakan untuk membuat jadwal pertemuan
(meeting plan) berupa tempat pertemuan, waktu pertemuan
atau rencana kerja yang berkaitan dengan waktu.

RSVP digunakan untuk mengetahui jumlah peserta yang hadir
dalam suatu acara yang kita rancang, yang berisikan kesediaan
peserta untuk hadir atau tidak dalam acara tersebut dan lain-
lainnya yang berkaitan dengan reservasi.

Party Invite digunakan untuk mengirim undangan secara online
serta kesediaan yang diundang untuk menghadiri acara yang
diadakan, isinya hampir sama dengan RSVP, namun bedanya
RSVP menentukan berapa peserta yang dapat hadir dalam
acara tersebut.

T-Shirt Sign Up digunakan untuk pemesanan fashion berupa
baju/jaket/celana/rok, di mana form tersebut berisikan nama
dan ukuran yang dipilih.

Event Registration digunakan hampir mirip dengan RSVP dan
party invite yaitu untuk registrasi kegiatan.

Form yang berkaitan dengan pekerjaan (Work)

Event Feedback digunakan untuk umpan balik berupa pendapat
terhadap kegiatan yang diselenggarakan.

Order Form digunakan untuk lembar memesan suatu produk.
Job Application digunakan untuk melamar pekerjaan yang

berisikan data pribadi (curriculum vitae) sesuai dengan
kebutuhan pekerjaan yang dilamar.
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4. Time Off Request digunakan untuk surat izin/cuti dari
pekerjaan yang berisikan alasan-alasan izin/cuti.
5. Work Request digunakan untuk hal-hal yang berkaitan dengan

pekerjaan seperti membutuhkan/keluhan terhadap pekerjaan
dan sebagainya.

6. Costumer Feedback digunakan untuk tanggapan pelanggan
terhadap produk atau jasa pada perusahaan bisnis atau jasa
tersebut.

6. Mengenal Adobe Animate
a. Pengenalan Awal Adobe Animate

Adobe Animate 2015 adalah salah satu versi dari animate. Kemampuan
dan fitur-fiturnya dapat dikategorikan sudah lengkap karena telah
memiliki fitur publish ke android yang terintegrasi ke Aplikasi Adobe
AIR memiliki kemampuan untuk mengakses data yang tersimpan
pada komputer klien atau smartphone sehingga MPI dapat dijalankan
pada smartphone dengan berbagai versi android. Adobe Animate
merupakan standar perancang dan pengembang profesional dalam
merancang dan mengembangan desain multimedia interaktif karena
dapat membuat gambar animasi, logo, navigasi/link web/android.
Sebelumnya adobe mengeluarkan adobe Animate, namun sejak tahun
2013 adobe memutuskan untuk menggantikan adobe Animate dengan
adobe animate. Aplikasi ini mendukung streaming video dan audio
sehingga adobe animate sangat cocok digunakan sebagai aplikasi untuk
merancang MPI karena semua konten pembuat MPI telah memenuhi
syarat yaitu gambar, animasi, teks, audio, video dan interaktif.

b. Membuka Adobe Animate

Prosedur standar dalam menjalankan Adobe Animate dengan Langkah-
langkah sebagai berikut:

1) Klik 2 kali pada ikon Adobe Animate pada desktop, akan tampil
gambar berikut:
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2)
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Gambar 11. Tampilan Membuka File Baru Animate

Memulai membuka lembar kerja baru, kita pilih Create New — Pilih
AIR for Android (pilihan AIR for android karena MPI yang kita rancang
berbasis android dengan ukuran standar 480px X 800 px), maka
akan tampil gambar lembar kerja (workspace) berikut:

Menubar Scene stage Panel Toolbox

.

layer timeline frame

Gambar 12. Menu pada Animate
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Komponen yang Akan Kita Gunakan dalam Merancang MPI berbasis

android ini terlihat pada menu utama Adobe animate berikut:

1)

2)

3)

4)

Menu Bar

Menu bar merupakan barisan menu yang terdiri dari File, Edit,
View, Insert, Modify, Text, Commands, Control, Debug, Window
dan Help.

Stage (Lembar Kerja)

Stage merupakan area putih/area kerja/lembar kerja untuk
meletakkan objek yang akan kita rancang. Stage berguna untuk
mendesain objek yang akan dianimasikan. Ada beberapa jenis objek
dalam stage antara lain:

a) Scene
Scene merupakan tempat mengumpulkan gambar atau frame
yang senada. Satu scene berisikan kumpulan frame-frame
gambaran rangkaian kejadian/kegiatan yang kita rancang.
Istilahnya MPI adalah produknya sedangkan scene bagian dari
produk.

b) Edit Scene adalah nama scene yang akan kita edit.

¢) Edit Symbols adalah nama simbol yang akan kita edit.

d) Zoom in, zoom out untuk mengatur besar kecil tampilan stage
atau lembar kerja.

Layer

Layer merupakan tempat menempatkan objek pada satu scene.

Frame

Frame merupakan tempat mengatur pergerakan animasi dengan

durasi waktu yang dikelompokkan dalam layer.

Timeline

Timeline merupakan panel yang berisikan kumpulan layer berupa

rangkaian gambar, teks, audio, video, script, animasi bergerak

membentuk movie atau simbol.

Panel

Panel menampilkan informasi yang berkaitan dengan ukuran

dan objek yang sedang diseleksi/dipilih serta digunakan untuk

mengatur setingan yang diperlukan pada objek. Panel berisikan:
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7)

a) Color Panel digunakan untuk memberikan warna pada objek

yang diseleksi serta mengatur komposisi warna.

b) Properties digunakan untuk menyeting publish file, properties
ukuran stages, dan histori swf.

Toolbox

Toolbox merupakan tempat perangkat kerja berupa alat-alat (tools)
untuk merancang dan menggambar objek pada stage. Bagian dari
toolbox sebagai berikut:

Selection Tool

Free Transform
Tool

Lasso

Pen

Line

I Oval tool

Pencil tool

Brush tool

Bone tool

Ink Bottle tool

Eraser tool

| Hand tool

Kita telah mengenal bagian-bagian dasar dari tampilan Animate
yang akan kita gunakan dalam merancang MPI. Selanjutnya kita akan
merancang MPI secara detail sehingga tujuan akhir kita adalah produk

MPI berbasis android.
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Move Tool

3D Rotation

Text

Rectangle

Polystar

Paint Brush

Paint Bucket

Eyedropper

Width Tool

Zoom Tool

Stroke Color

"

Fill Color

Gambar 13. Tampilan Toolbox
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a. Bekerja dengan Scene

Sebelumnya kita telah membahas pengertian scene. Scene berguna untuk
memudahkan kita dalam menjalankan beberapa frame, artinya ketika
frame pada timeline scene pertama habis maka secara otomatis akan
langsung berpindah ke frame pada timeline scene kedua dan seterusnya.
Pada MPI yang kita rancang, scene berguna untuk menghubungkan
scene satu ke scene lainnya sehingga frame pada timeline scene tidak
terlalu panjang durasinya serta layer-layer pada timeline tidak banyak
sehingga tidak membingungkan kita dalam merancang MPL Ketika kita
membuka file baru Animate, maka akan terlihat pada stage (area kerja)
bagian atas kanan yaitu scene. Agar memudahkan kita dalam mengatur
banyak scene yang akan kita gunakan sesuai dengan storyboard yang kita
rancang maka kita berikan judul scene untuk memudahkan kita dalam
merancang, mengedit scene nantinya. Scene yang kita rancang harus
sesuai dengan storyboard yang telah kita siapkan pada pembahasan
sebelumnya, jika pun ada perbedaan saat merancang scene MPI namun
tidak terlalu jauh berbeda dengan storyboard. MPI yang akan kita
rancang ada beberapa scene yaitu scene:

1) Intro untuk menampilkan cover depan (tampilan pembuka) produk
MPL

2) Home untuk penjelasan singkat MPI.

3) Menu untuk pilihan menu MPL

4) KD untuk menu Kompetensi Dasar

5) Petunjuk untuk menu petunjuk pengguna
6) Materi untuk menu materi pembelajaran
7) Latihan untuk Latihan soal

8) Referensi untuk referensi berupa daftar Pustaka, unduh modul,
evaluasi online, forum diskusi.

9) Profil untuk profil pembuat MPL

10) Materil untuk penjelasan isi materi 1, jika materi yang akan kita
tampilkan pada MPI ada beberapa materi sesuai dengan KD,
kita perbanyak scene dengan memberikan nama sesuai dengan
materinya. Jika pada materi ada sub materi maka kita tambahkan
juga scene materi, contoh materila, materilb dan seterusnya. Pada
MPI ini kita akan membuat 2 versi scene materi pembelajaran yaitu:
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a) Versi 1 yaitu tampilan materi pembelajaran menggunakan
scroll bar. Isi materi pembelajaran dibaca dengan menggunakan
scroll bar dari atas ke bawah. Kapasitas isi materi hingga 1600
kata per scene.

b) Versi 2 yaitu tampilan materi pembelajaran menggunakan
slide per slide. Slide per slide yaitu isi materi pembelajaran
hanya berisikan penuh ukuran stage (480px X 800 px), materi
lanjutannya berpindah ke stage lainnya, tidak menggunakan
scroll bar.

11) Videomateri berisikan kumpulan video tutorial pembelajaran.
Video materi berisikan video permateri. Pada materi kita juga dapat
menambahkan lembar kerja siswa yang tersimpan dalam format
pdf.

Langkah-langkah memberikan nama scene sebagai berikut:
1) Pilih Menu Window —> Pilih Scene (Shift + F2), maka akan tampil
layar scene berikut:

Gambar 14. Memberi Nama Scene

2) Klik dua kali pada tulisan scene — ubah nama scene dengan judul
intro. Kita bisa memberikan istilah judul sesuai dengan keinginan
kita untuk memudahkan kita dalam mengingat judul-judul scene
yang kita berikan. Maka nama scene telah tersimpan. Pada edit
scene kita dapat melihat judul scene yang telah tersimpan di file
MPIL.
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Kita dapat membuat banyak scene selanjutnya sesuai dengan
storyboard yang kita rancang dengan langkah-langkah berikut:

1) Pilih Menu Insert - Pilih Scene, maka akan tampil scene 2 seperti
gambar berikut:

Gambar 15. Menambahkan Scene

2) Lanjutkan pemberian nama judul scene 2 dengan Langkah-langkah
memberikan nama scene yang telah dijelaskan sebelumnya.

Pada contoh MPI yang kita rancang sedikitnya 15 scene yang akan
kita rancang menjadi satu produk MPI berbasis android. Scene telah kita
berikan judul. Selanjutnya kita akan bekerja dengan teks dan timeline.

b. Bekerja dengan Teks

Teks digunakan sebagai penjelasan singkat tentang MPI, penunjuk

tema atau materi pembelajaran. Pada Animate ada tiga jenis teks yaitu:

1) Static Text yaitu teks yang bersifat tetap, tidak dapat diubah-ubah,
hanya dapat dilihat saja.

2) Dynamic Text yaitu teks yang dapat kita ubah sesuai dengan
kebutuhan. Biasanya digunakan untuk membuat skor akhir soal
Latihan atau skor game.

3) Input Text yaitu teks yang digunakan memasukan nilai berupa data
berbentuk form.
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Pada bagian Character text ada beberapa istilah, yaitu

1) Embed. Embed yaitu jenis font yang telah diinstal dan disertakan
(embed) pada device font Animate yang digunakan sesuai dengan
font pada computer, sehingga secara otomatis Animate akan
menyesuaikan jenis font yang memiliki kemiripan dengan jenis
font tersebut.

2) Leading digunakan untuk mengatur jarak baris, menggunakan skala
ukuran point (pt).

3) Size merupakan ukuran font.

4) Color Text digunakan untuk memberikan warna pada teks yang
kita seleksi.

c. Bekerja dengan Objek

Objek merupakan suatu tipe data berupa teks, gambar, suara yang
digunakan untuk mengontrol movie. Objek pada Animate merupakan
objek yang terlihat jelas dan abstrak (tidak terlihat seperti tanggal, data
input dari mouse). Objek terlebih dahulu diberikan penamaan yang
disebut Instance Of dapat dilihat pada gambar berikut:

Sebelum objek didefinisikan dilakukan predefined class dengan
melakukan convert to symbol pada objek agar objek tersebut dapat
digunakan sebagai simbol. Objek yang kita buat otomatis akan
tersimpan pada library sebagai tempat penyimpanan simbol. Ada tiga
jenis simbol dengan karakter yang berbeda-beda dalam pembuatan
animasi, yaitu:

1) Movie clip merupakan jenis simbol yang digunakan untuk objek
yang bergerak (objek dinamis/beranimasi).

2) Button merupakan jenis simbol yang digunakan untuk menjalankan
perintah-perintah tertentu, berupa tombol operasional.

3) Graphic merupakan jenis simbol yang digunakan pada objek yang
tidak bergerak (objek statis).

Ada empat pengaturan tombol seperti gambar berikut:
1) Up merupakan tampilan awal sebelum cursor menyentuh tombol.
2) Over merupakan tampilan Ketika cursor menyentuh tombol.
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3) Down merupakan tampilan Ketika cursor menyentuh tombol dan
kita mengklik tombol tersebut. Agar terlihat perbedaan up, over
dan down, dapat kita tambahkan animasi perubahan warna atau
ukuran objek bergerak sesuai keinginan.

4) Hit merupakan tampilan yang membuat tombol menjadi transparan
namun tetap dapat kita klik tombol tersebut. Jika menggunakan
hit, maka tiga pengaturan lainnya tidak perlu digunakan dengan
kata lain kita kosongkan.

a. Bekerja dengan Actionscript

Actionscript merupakan Bahasa pemograman pada Animate.
Actionscript (AS) yang akan kita gunakan adalah Actionscript 3.0.
(AS3) Pemograman pada Animate berisikan kumpulan urutan perintah
berisikan kode (coding) ke computer untuk mengendalikan objek atau
movie. As berguna untuk mengatur timeline untuk mengendalikan
animasi, contohnya objek yang awalnya diam kemudian diberikan
tombol sehingga objek tersebut bergerak sehingga membutuhkan
pengaturan yang menggunakan kode. AS3 dikerjakan pada panel Actions
dengan menekan tombol F9 atau pilih menu Window —> pilih Actions,
maka akan tampil panel actions seperti gambar berikut:
1) Penulisan Kode
Penulisan kode tidak boleh salah, harus diperhatikan secara
detail. Pada proses pengecekan kode, jika terjadi kesalahan syntax
(kata perintah), string dan sebagainya maka proses akan terhenti,
Kesalahan akan ditampilkan pada panel Compiler Error, contoh
kesalahan dalam menuliskan kode seperti salah satu tanda petik
pada bagian awal tidak terketik/dihilangkan, maka ketika dijalankan
maka akan muncul kesalahan pada panel Compiler Error akan
dijelaskan kesalahan yang terjadi
2) Syntax (sintaks)
Sintaks merupakan symbol, kata dan fungsi yang digunakan pada
struktur kode pemograman. Sintaks pada Animate merupakan
seperangkat aturan yang harus dipenuhi dalam penulisan kode.
Penulisan AS3 yang sering terjadi syntax error:
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a)

c)

Format Case Sensitive

Format Case Sensitive merupakan bentuk dasar yang harus
ditulis dengan benar dan tepat, jika terdapat satu perbedaan
maka akan terjadi perbedaan yang jelas, contohnya jika semua
kalimat menggunakan huruf kecil maka pendeklarasiannya pun
harus tulisan kecil seperti contoh:

tombol home.addEventlListener (MouseEvent.

CLICK,home evaluasi 1); (barisl)
function home evaluasi2(event:MouseEvent) :voi
d{ (baris2)
gotoAndPlay (45, “home”) ; (baris3)

}

Akan terjadi syntax error, seharusnya pada tulisan pada baris2
seharusnya mengikuti baris pertama home evaluasil bukan
home_evaluasi2 sehingga tidak dapat dijalankan (compile).
Semicolon

Semicolon (;) atau titik koma dalam AS3 merupakan akhir dari
sebuah baris kode. Jika pada akhir kode diberikan titik koma,
maka dinyatakan sebagai baris perintah baru.

Contoh:

tombol_home.addEventListener (MouseEvent.CLICK,
home evaluasil); (barisl)

function home evaluasil (event:MouseEvent) :voi
d{ (baris2)
gotoAndPlay (45, “home”) ; (baris3)

}

Pada baris pertama, akhir kode terdapat titik koma maka pada
baris kedua merupakan baris dengan perintah baru. Pada baris
kedua pada akhir kode tidak terdapat titik koma maka baris
ketiga merupakan lanjutan perintah baris kedua.

Whitespaces (Ruang Kosong)

Whitespaces pada pemograman digunakan untuk pengkondisian
jarak penulisan, baik tab, enter, spasi atau kode. Ruang kosong
dapat kita lihat pada baris yang menjorok masuk atau adanya
baris yang dikosongkan agar terlihat jarak antara kode fungsi
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d)

(function) baris 1 dengan kode fungsi baris selanjutnya seperti
contoh berikut:

Contoh:

Function fl ClickToGoToAndStopAtFrame 36 (event
:MouseEvent) :void

gotoAndPlay (13) ;
}
Command (komentar)
Command merupakan komentar yang berisikan catatan
keterangan yang diberikan pada kode yang sedang ditulis untuk
memudahkan pengecekan apabila kode yang digunakan dalam

satu layer banyak. Tanda yang digunakan untuk menuliskan
komentar, yaitu:

1) Tanda//....isi komentar, komentar satu baris.
Contoh:
//Click to Go to Next Frame and Stop
74 R isi komentar */, komentar lebih dari satu
baris. Contoh:
/* Click to Go to Next Frame and Stop

Clicking on the specified symbol instance
moves the playhead to the next frame and
stops the movie.

%y
Tulisan komentar berwarna abu-abu pada layar.
Variable declaration

Variable declaration merupakan nilai dan nama yang
dideklarasikan pada AS3 menggunakan kata kunci var diikuti
dengan nama variabel, jenis data, serta nilai variabel. Contoh:

Hevaluasi.text=steva.toString();

Pada sintaks di atas dijelaskan bahwa Hevaluasi berbentuk teks
dideklarasikan menggunakan jenis data string, nilai variabel
yaitu steva.
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3)

38

Operator

Operator menggunakan simbol-simbol operasional yang digunakan
dalam operasi matematika seperti perkalian (*), pembagian (/),
penjumlahan (+), pengurangan (-),sama dengan (=) dan sebagainya.
Function (Fungsi)

Function merupakan fungsi yang dipanggil atau diaktifkan yang
terdiri dari satu atau beberapa kode dalam satu blok untuk
menyederhanakan operasi pada AS sehingga dapat digunakan
beberapa kali.

Contoh:
function fl ClickToGoToAndStopAtFrame 36 (event:Mo
useEvent) :void
{
gotoAndPlay (13);
}
Menambahkan EventListener
EventListener merupakan urutan kejadian yang diperintahan
pada suatu objek. EventListener pada AS 3 digunakan untuk
membentuk interaktivitas. Mengidentifikasi suatu event diperlukan
addEventListener. Event pada AS3 antara lain:
a) MouseEvent merupakan event dalam bentuk mouse dengan
trigger click atau hover.
Penggunaan MouseEvent berkaitan dengan addEventListener.
AddEventListener digunakan untuk memanggil sebuah fungsi
yang memproses animasi yang kita buat. Ada dua penerapan
MouseEvent yaitu fitur drag and drop, drag and snap.

Contoh:

import flash.events.MouseEvent; (Baris 1)

tombol home.addEventListener (MouseEvent.CLICK,

home280) ; (Baris 2)

function home280 (event:MouseEvent) :void{
(Baris 3)

goteAndPlay(l, “hcme”) ; (Baris 4)

}
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Kode AS3 untuk tombol home:

1. Baris 1: Kita harus mengimportkan event yang kita
gunakan dengan menggunakan import flash.event.
MouseEvent;

2. Baris 2: Setelah nama instance tombol_home
dilanjutkan addEventListener untuk mengidentifikasi
MouseEvent.CLICK artinya Ketika tombol diklik maka
jalankan fungsi home280.

3. Baris 3: untuk membuat function home280 dengan pemicu
atau event dan tidak mengembalikan nilai (mempunyai
tipe keluaranvoid) -(event:MouseEvent):void(

4. Baris 4: gotoAndPlay(1,”home”);menjalankan scene
home. AS3 digunakan untuk menjalankan home.

b) FrameEvent merupakan event yang diletakan pada keyframe.

¢) Movie Clip Event merupakan event yang diletakkan pada
movieclip.

d) KeyboardEvent digunakan untuk sebuah event yang terjadi
Ketika mendapat nilai input dari keyboard.

Event yang banyak kita gunakan pada perancangan MPI ini
adalah MouseEvent.
Event handler
Event handler digunakan untuk membuat komponen custom dari
tampilan yaitu metode callback sebagai event handler default.
Event handler yang kita gunakan dalam pembuatan MP1 ini adalah
TouchEvent dipanggil terjadi jika ada gerakan layar sentuh.
Contoh:
import flash.events.TouchEvent; import flash.
desktop.NativeApplication; stop();
Multitouch.inputMode = MultitouchInputMode.
TOUCH_POINT; yaexit. addEventListener (TouchEvent.
TOUCH END, exitApp30); function exitApp30 (event:
Touchgvent} :void {
NativeBpplication. nativehpplication.exit ();

}
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tidakexit.addEventListener (MouseEvent.CLICK,
exit31l); function exit3l(event:MouseEvent) :void{
gotoAndPlay (20} ;

}

Saat kita mempelajari tentang event, ada beberapa import flash

event yang kita gunakan antara lain:

a)
b)
c)

d)

b.

Import flash.events.MouseEvent digunakan untuk mouse event.
Import flash.events. TouchEvent digunakan untuk touch event.

Import flash.dekstop.NativeApplication digunakan untuk native
application.

Import flash.net. URLRequest digunakan untuk memanggil link
URL melalui internet.

Bekerja dengan Timeline

Bekerja dengan timeline pada buku ini menjelaskan tentang Langkah-
langkah merancang dari tampilan intro hingga tampilan profil, sehingga
diharapkan setelah mempelajari dan mempraktikan merancang MPI,
akan menghasilkan hasil karya berupa Media Pembelajaran Interaktif
berbasis android yang sesuai dengan kebutuhan.

a)

Tampilan Intro

Sebelumnya telah dijelaskan tentang timeline, Sebelum membuat scene
intro, ada baiknya kita menyimpan file yang akan kita rancang pada
drive penyimpanan dengan langkah-langkah sebagai berikut:

1y

2)

40

Pilih Menu File -> Pilih Save As -> Ketik Nama File (“Seni
Budaya”) -> Save As Type: Animate Documents (*.fla). Simpan
dalam format fla untuk memudahkan kita dalam mengedit media
pada waktu selanjutnya. Lakukan penyimpanan (File -> Save
atau tekan tombol ctrl+s) sesering mungkin agar media yang kita
rancang tersimpan dengan baik.

Selanjutnya kita membuat scene intro. Pilih Menu File

-> Import -> Pilih Import to stage seperti gambar berikut:
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3)

Gambar 16. Menambahkan Background pada Stage

Pilih drive penyimpanan file background -> Klik Open. Atur posisi
background pada panel properties dengan size width (W): 480,
height (H): 800 dan posisi x: 0, y: O seperti gambar berikut:

Gambar 17. Mengatur Posisi Background

Klik layer] pada timeline, akan tersortir layer 1.

Klik frame 50 pada frame, klik kanan pilih insert frame, maka akan
terbentuk frame penuh dari frame 1 hingga frame 50 berwarna abu-
abu yang diakhiri kotak putih pada frame 50. Layer 1 dapat kita
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6)

7)
8)

9)

10)

ganti nama dengan cara klik dua kali pada layer 1, isi nama backg.
Selanjutnya kita dapat menambahkan background yang telah kita
desain pada photoshop.

Pada timeline akan terlihat bulatan hitam pada frame, bulatan hitam
tersebut menandakan bahwa frame tersebut berisikan objek.
Selanjutnya, kita mengatur posisi objek tersebut.

Klik objek pada stage, Pilih Properties pada panel. Ubah position
and size. Isi X=0, Y=0, karena objek sudah sesuai ukuran W
(width) = 480, H (Height) = 800 jadi tidak perlu kita ubah.
Tekan tombol Enter pada keyboard, maka posisi objek tepat
ditengah stage. Agar dapat melihat tampilan objek pada stage
penuh dapat kita seting zoom dengan tekan ctrl+ + untuk zoom
in (perbesar), ctrl+-untuk zoom out (perkecil) atau menekan area
zoom sesuai dengan yang kita inginkan ukuran tampilan stage.
Ganti nama layer dengan klik dua kali pada layer, ganti dengan
nama backg.

Background telah ditambahkan pada layer, selanjutnya kita akan

merancang layer 2 yang berisikan animasi loading, ketika masuk ke
home harus menunggu proses loading terlebih dahulu. Langkah-langkah
membuat batas tempat animasi loading terlebih dahulu sebagai berikut:

1)

2)
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Pilih Menu Insert —> Pilih Timeline —> Pilih layer, maka pada
timeline akan tampil layer 2 atau dengan cara klik tanda seperti
dokumen pada bagian bawah timeline, klik new layer. Ganti nama
layer 2 dengan nama “batas loading” (optional)

Posisikan cursor pada frame 1 pada layer 2, pilih rectangle tool
pada toolbox atau tekan tombol R. Perhatikan cursor harus dalam
keadaan posisi selection tool, jika belum klik selection tool atau
tekan tombol v.

Setelah klik rectangle tool (R), cursor akan berubah + menandakan
rectangle tool aktif. Arahkan rectangle pada objek, posisikan sesuai
keinginan seperti gambar berikut:
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Gambar 18. Posisi Loading pada Frame 1

Perhatikan layer 2 pada timeline maka akan terlihat bulatan hitam
pada frame.

Selanjutnya, posisikan cursor pada frame 50, klik kanan pilih Insert
keyframe. Kemudian panjangkan rectangle sesuai keinginan dengan
mengatur ukuran objek dengan klik Free Transform Tool pada toolbox
atau tekan tombol Q pada keyboard untuk mengubah ukuran objek
seperti gambar berikut:

LK FEMAE LS [ AREN
NTERANTI

Gambar 19. Memanjangkan Rectangle pada Frame 50
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6) Posisikan cursor pada frame 25, klik kanan pilih Create Shape Tween
maka akan tampil garis panah dari frame 1 ke arah frame 50 seperti
gambar berikut:

£l FEMBELAJARLN
INTIRARTIT

Gambar 20. Create Shape Tween

7) Melihat animasi pergerakan loading, posisikan cursor pada frame
1 tekan Enter pada keyboard.

Setelah kita merancang animasi loading selanjutnya kita membuat
teks Loading pada layer 3, membuat layer 3 ikuti tahap menambahkan
layer seperti penjelasan sebelumnya. Selanjutnya kita akan menambahkan
teks dengan Langkah-langkah sebagai berikut:

1) Posisikan cursor dalam keadaan selection tool dan frame 1 pada
timeline, kemudian klik text tool pada toolbox. Ketik LOADING
pada stage sesuai dengan keinginan kita seperti gambar berikut:
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Gambar 21. Menambahkan Teks Loading
2) Maka scene 1 intro telah selesai kita rancang.

b) Tampilan Home
Langkah merancang tampilan home tidak jauh berbeda dengan tampilan
intro, Langkah-langkah merancang tampilan home berikut:

1) Klik Scene Home pada Edit Scene, maka akan tampil stage kosong
scene home.

2) Masukan background yang telah kita siapkan dengan import to
stage, ikuti tahap menambahkan background pada scene seperti
layer 1 pada scene 1.

3) Posisikan cursor pada frame 50 —> Klik kanan pilih Insert frame.

Kemudian kita menulis dan mengedit teks pada scene 2 dengan
langkah-langkah sebagai berikut:

1) Klik New layer —> Ganti nama new layer dengan nama “teks”

2) Klik Text tool (t) pada toolbox atau tekan tombol t di mana posisi
cursor selection tool (v), arahkan pada stage. Klik pada stage, maka
muncul gambar berikut:
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Gambar 22. Teks Pembuka pada Home

Menulis Teks

Saat menulis teks, maka otomatis panjang dan lebar kotak akan
mengikuti Panjang tulisan. Sebagai contok tulisan teks:

“Selamat datang di Media Pembelajaran Interaktif”

Mata Pembelajaran Seni Budaya Kelas VII SMP

Pada media ini kamu bisa mempelajari Materi Pembelajaran Seni
Musik

TERIMA KASIH
By. Irdhan Epria Dharma Putra, M.Pd

Jika ingin menghasilkan tulisan bermacam kreasi dapat dirancang
saat membuat background home pada aplikasi adobe photoshop.

Mengedit Teks

Tampilan teks dapat kita atur dengan membuka properties pada panel.
Gunakan Static text dengan tipe classic text. Selanjutnya karakter teks
dan posisi teks dapat kita atur sesuai dengan tampilan teks.

Teks telah kita rancang. selanjutnya kita akan memberikan animasi
home (gambar rumah) pada stage agar lebih kelihatan menarik dan
menandakan akan mulai masuk pada menu utama.
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Selanjutnya kita akan membuat objek home berupa button. Objek

yang digunakan adalah objek tombol. Langkah-langkah membuat
tombol sebagai berikut:

1. Klik menu File - Import to stage, pilih ikon home di folder file
Animate yang telah kita siapkan

2. Klik Open, atur ukuran ikon home dengan klik Free Transform Tool
(Q) pada toolbox dan berikan tulisan KLIK>>, <<KLIK serta
HOME pada ikon home. seperti gambar berikut:

Gambar 23. Menambahkan lkon Home

3. Posisikan cursor pada selection tool (V) dan pada posisi frame 1,
Pilih Menu Modify — Pilih Convert to symbol atau tekan tombol
F8 pada keyboard seperti gambar berikut:

Gambar 24. Convert to Symbol
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4. Berikan nama pada symbol, contoh THome artinya Tombol Home.
Buatlah istilah-istilah yang memudahkan kita untuk mengingatnya.

5. Pilih Type Button, Klik OK. THome dapat kita lihat pada panel Edit
Symbols. Objek telah berupa button.

6. Atur Properties button pada panel, isi <instance name> dengan
tombol_home. Tekan Enter pada keyboard seperti gambar berikut:

Gambar 25. Instance Name

c. Bekerja dengan Audio

Audio atau sound atau suara merupakan elemen utama pada aplikasi
multimedia interaktif. Suara dapat berupa efek suara Ketika kita
menekan tombol atau memberikan suara rekaman (dubbing) untuk teks.
Suara pada tombol dapat berupa musik latar, suara alam seperti bunyi
gemericik air, angin dan sebagainya ataupun efek suara yang terdapat
pada fasilitas audio Animate. Pada MPI ini kita akan menambahkan
audio berupa suara rekaman (dubbing). Suara tersebut berupa kalimat
Selamat datang yang terletak pada scene home. Kita dapat merekam
suara kita sesuai dengan ketikan teks yang ada pada scene home
menggunakan smartphone yang kemudian disimpan dengan format
penyimpanan WAV atau MP3 dengan frekuensi suara di bawah 44.100.
Berikut langkah-langkah menambahkan audio pada scene home:
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2)
3)

4)

Melanjutkan scene home, Pilih New Layer pada timeline - ganti
nama: sound

Posisikan cursor pada frame 1, Pilih menu File - Import to library

Klik pada library - Pilih sound yang telah kita sediakan - kemudian
drag ke stage seperti gambar berikut:

Maka secara otomatis sound akan mengikuti Panjang frame yang
tersedia.

Kemudian kita dapat memberikan Efek perubahan ukuran ketika

di klik home dengan Langkah-langkah berikut:

1)

2)

3)

4)

Klik Edit Symbols -> Pilih THome, cursor berada pada frame up,
maka akan tampil gambar berikut:

Gambar 26. Tombol Home

Atur pengaturan tombol, posisikan cursor pada frame down, klik
kanan pilih Insert Keyframe, maka bulatan hitam akan terisi pada
frame down.

Selanjutnya Posisi cursor pada frame Down, Klik kanan pilih
Insert Keyframe, pilih free transform tool (Q). Atur ukuran tombol
menjadi lebih kecil dari ukuran awal, ubah ukuran dengan posisi
tetap di tengah namun objek menjadi kecil.

Tekan Enter untuk melihat perubahan ukuran objek.
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Pada frame down kita dapat menambahkan efek audio, Ketika
tombol diklik maka akan mengeluarkan suara tombol.
1) Posisikan cursor pada frame down -> klik objek -Buka Properties.
2) Pilih Sound > Pilih Name Sound_Home-TombolTV.wav, jika belum
terdapat sound pada library, kita dapat mengimport sound dari file
yaitu dengan: Pilih Menu File -> Import to library -> Pilih drive
yang menyimpan audio/sound, maka tampil gambar berikut:

Gambar 27. Import Sound ke Library

3) Selanjutnya buka properties, pilih sound yang pas diletakkan pada
frame down.

Gambar 28. Menambahkan Sound pada Frame
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Kita dapat menambahkan suara rekaman pada materi pembelajaran

jika dianggap perlu sehingga menampilkan pembelajaran yang
memperhatikan gaya belajar siswa. Ada siswa yang cenderung lebih
menyukai pembelajaran dengan mendengarkan ketimbang membaca
sehingga menggunakan audio dapat membantu pembelajaran lebih
menyenangkan bagi siswa yang memiliki gaya belajar auditorial tersebut.

Selanjutnya kita akan menghubungkan scene intro dengan scene

home dengan menggunakan action script dengan Langkah-langkah
berikut:

1)

2)
3)

4)

Klik New Layer pada timeline —> tekan tombol F9 atau Klik
Window —> Pilih Actions, maka akan tampil gambar berikut:

Gambar 29. Tampilan Actionscript

Posisikan cursor pada frame 1
Ketik kode AS3 pada layer actions:

flash.events.McouseEvent;

Posisikan cursor pada layer home frame 1, tekan tombol F9, ketik
stop(); untuk menghentikan pergerakan animasi pada frame akhir.
Catatan: Perhatikan dalam penulisan huruf, besar kecil huruf kapital
mempengaruhi pembacaan program pada sistem komputer.
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5) Setelah mengetik kode, selanjutnya kita akan mengcompile
actionscript dengan tekan tombol ctrl+enter. Apabila compile
berhasil maka akan tampil gambar berikut:

Gambar 30. Compile Test Movie pada Animate

Namun jika compile mengalami syntax error maka dapat kita cek
kesalahan pada compiler error. Navigasi scene intro menuju scene home
telah berhasil kita jalankan. Selanjutnya kita akan merancang halaman
menu utama sesuai dengan storyboard.

c¢) Merancang Halaman Menu Utama

Menambahkan scene homel dapat kita lakukan dengan mengikuti

Langkah-langkah merancang home dari poin 1 hingga 3. Selanjutnya

tambahkan animasi teks dari tulisan kecil membesar dengan Langkah-

langkah sebagai berikut:

1) Klik Insert layer pada timeline -> Ganti nama layer: teks.

2) Posisi cursor pada frame 1, Pilih Text pada toolbox -> drag ke stage,
ketik tulisan “Menu Utama Materi Pembelajaran Seni Musik Kelas
7 SMP”. Perkecil teks, posisikan teks diatas stage. Ubah jenis font
pada properties, klik embed agar tidak terjadi perubahan teks ketika
media dibuka pada smartphone.
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3) Posisi cursor pada frame 10 klik kanan insert keyframe, kemudian
perbesar teks secara proporsial dengan memperhatikan ukuran
stage.

4) Posisi cursor pada frame 5, Klik kanan -> Pilih Insert Classic
Tween. Langkah ini hampir sama tahapannya dengan animasi batas
loading pada scene intro. Berikut gambar dari rancangan animasi
perbesaran teks:

Gambar 31. Animasi Bergerak dan Perbesaran Teks

5) Menambahkan garis di bawah judul dengan Langkah-langkah
sebagai berikut:

Insert layer pada timeline -> ubah nama layer: garis.

Pada frame 5, klik kanan insert frame. Selanjutnya pada frame
6 insert keyframe.

c. Pilih rectangle tool pada toolbox, posisikan garis di samping
kiri stage tepat di bawah tulisan judul.

d. Pada frame 15, insert keyframe, ubah posisi garis ke tengah
tepat di bawah judul. Klik kanan pilih Create Classic Tween.

e. Padaframe 16 lakukan kembali insert keyframe dan pada frame
70 insert frame, tampilan gambar seperti berikut:
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MENU UTAMA
MATER!I PELAJARAN SENI MUSIK
KELAS VIl SMP

Gambar 32. Menambahkan Animasi Garis

Ketika kita menambahkan layer, otomatis posisi akhir frame adalah
frame 70 karena background telah kita atur hingga frame 70. Agar
frame bisa kita ubah menjadi lebih sedikit dengan memblok frame
yang akan kita buang, kemudian klik kanan -> Pilih Remove frame,
maka frame yang kita blok akan terhapus.

6) Animasi teks telah kita rancang. Selanjutnya kita akan menambahkan
tombol-tombol berisikan menu pilihan, yaitu 1) petunjuk pengguna,
2) Kompetensi Dasar, 3) Materi Pelajaran, 4) Latihan Soal, 5)
Referensi, 6) Profil. dengan langkah-langkah sebagai berikut:

a) Merancang Menu Petunjuk Pengguna:

1. Insert layer pada timeline -> ubah nama layer: tombol
petunjuk.
Pada frame 15, klik kanan insert frame.

3. Selanjutnya pada frame 16 insert keyframe. Pilih menu File
-> Insert to stage -> Pilih tombol yang telah kita siapkan
sebelumnya pada drive penyimpanan -> Open. Posisikan
tombol tersebut di bawah garis sebelah kiri. Atur ukuran
objek W:100, H:100 dan tambahkan teks di bawah objek,
ketik tulisan 1. PETUNJUK dengan ukuran font 15pt.

4. Selanjutnya kita akan menambahkan animasi perbesaran
tombol, Posisi cursor pada frame 20 -> insert keyframe.
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10.

11.

12.

Pada frame 16, perkecil objek dengan mengatur ukuran
objek dengan free transform tool (v) pada objek.

Kemudian posisikan cursor antara frame 16-20 -> klik
kanan pilih Create Classic Tween.

Pada frame 21 lakukan kembali insert keyframe dan pada
frame 70 insert frame, tampilan gambar seperti berikut:

Gambar 33. Animasi Tombol Pengguna

Agar tampilan tombol rapi, kita dapat menggunakan garis
bantu dengan pilih menu View -> Rules, maka akan tampil
rules. Pada rules, Drag dari angka penggaris yang diatas
(Horizontal) hingga akan terlihat garis bantu sama juga
dengan garis vertikal dengan drag dari rules samping kiri.

Posisikan cursor pada layer tombol pengguna dan pada
posisi frame 21, Pilih Menu Modify - Pilih Convert to
symbol atau tekan tombol F8 pada keyboard (hampir sama
dengan langkah-langkah convert to symbol pada scene
home)

Berikan nama pada symbol: TPengguna

Pilih Type Button, Klik OK. TPengguna dapat kita lihat
pada panel Edit Symbols. Objek telah berupa tombol.
Atur Properties button pada panel, isi <instance name>
dengan tombol_pengguna.

Agar ada animasi perubahan bentuk dapat kita lakukan
seperti pada tahap kita memberikan animasi perubahan
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bentuk pada scene home (lihat: bekerja dengan audio).
Kita akan sedikit mengulang bagaimana cara membuat
animasi perubahan bentuk dengan Langkah-langkah:

13. Klik Edit Symbols -> Pilih TPengguna, cursor berada pada
frame up.

14. Atur pengaturan tombol, posisikan cursor pada frame
down, klik kanan pilih Insert Keyframe, maka bulatan hitam
akan terisi pada frame down.

15. Selanjutnya Posisi cursor pada frame Down, Klik kanan
pilih Insert Keyframe, pilih free transform tool (Q). Atur
ukuran tombol menjadi lebih kecil dari ukuran awal, ubah
ukuran dengan posisi tetap ditengah namun objek menjadi
kecil.

16. Tekan Enter untuk melihat perubahan ukuran objek.

Langkah-langkat tersebut dapat kita lakukan pada tombol-

tombol lain yang memerlukan perubahan bentuk/warna ketika

tombol tersebut disentuh sehingga terlihat lebih menarik.

Selain animasi perubahan bentuk/warna, kita juga dapat

menambahkan efek sound/audio pada animasi perubahan

bentuk/warna tersebut (lihat:bekerja dengan audio).
b) Merancang Menu Kompetensi Dasar (KD):

1. Insert layer pada timeline -> ubah nama layer: tombol

Kompetensi.

Pada frame 20, klik kanan insert frame.

Selanjutnya pada frame 21 insert keyframe ->Pilih menu
File -> Insert to stage -> Pilih tombol yang telah kita
siapkan sebelumnya pada drive penyimpanan -> Open.
Posisikan tombol tersebut di bawah garis sebelah kanan
setelah tombol petunjuk pengguna. Atur ukuran objek
W:100, H:100 dan tambahkan teks di bawah objek, ketik
tulisan 2. KOMPETENSI DASAR dengan ukuran font
15pt.

4. Selanjutnya kita akan menambahkan animasi perbesaran
tombol, Posisi cursor pada frame 25 -> insert keyframe.
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10.

Selanjutnya pada frame 31 insert keyframe -> Pilih meny
File -> Insert to stage -> Pilih tombol yang telah kita
siapkan sebelumnya pada drive penyimpanan -> Open,
Posisikan tombo] tersebut dj bawah tombo] kompetensi
dasar. Atur ukuran objek W:100, H:100 dan tambahkan
teks di bawah objek, ketik tulisan 4. LATIHAN SOAL
dengan ukuran font 15pt.

Selanjutnya kita akan menambahkan animasi perbesaran
tombol, Posisi cursor pada frame 35 -> insert keyframe.
Pada frame 31, perkecil objek dengan mengatur ukuran
objek dengan free transform tool (v) pada objek.
Kemudian posisikan cursor antara frame 31-35 -> Klik
kanan pilih Create Classic Tween.

Pada frame 36 lakukan kembali insert keyframe dan pada
frame 70 insert frame, tampilan gambar seperti berikut:

Gambar 36. Animasi Tombol Latihan Soal

Posisikan cursor pada layer tombol latihan dan pada posisi
frame 36, Pilih Menu Modify - Pilih Convert to symbol
atau tekan tombol F8 pada keyboard.
Berikan nama pada symbol: TLatihan

Pilih Type Button, Klik OK. TLatihan dapat kita lihat pada
panel Edit Symbols, Objek telah berupa tombol.
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11. Atur Properties button pada panel, isi <instance name=>

dengan tombol latihan.
e) Merancang Menu Referensi:

1. Insert layer pada timeline -> ubah nama layer: tombol
referensi.

9. Pada frame 35, klik kanan insert frame.
Selanjutnya pada frame 36 insert keyframe -> Pilih
menu File -> Insert to stage -> pilih tombol yang telah
kita siapkan sebelumnya pada drive penyimpanan ->
Open. Posisikan tombol tersebut di bawah tombol materi
pelajaran. Atur ukuran objek W:100, H:100 dan tambahkan
teks di bawah objek, ketik culisan 5. REFERENSI dengan
ukuran font 15pt.

4. Selanjutnya kita akan menambahkan animasi perbesaran
tombol, Posisi cursor pada frame 40 -> insert keyframe.

5. Pada frame 36, perkecil objek dengan mengatur ukuran
objek dengan free transform tool (v) pada objek.

6. Kemudian posisikan cursor antara frame 26-40 -> klik
kanan pilih Create Classic Tween.

7. Pada frame 41 lakukan kembali insert keyframe dan pada

frame 70 insert frame, tampilan gambar seperti berikut:

Gambar 37. Animasi Tombol Referensi

8. Posisikan cursor pada layer tombol referensi dan pada
posisi frame 41, pilih Menu Modify - Pilih Convert to
symbol atau tekan tombol E8 pada keyboard.
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10.

11.

Berikan nama pada symbol: TReferensi
Pilih Type Button, Klik OK. TReferensi dapat kita lihat
pada panel Edit Symbols. Objek telah berupa tombol.

Atur Properties button pada panel, isi <instance name>
dengan tombol referensi.

Merancang Menu Profil:

1

Insert layer pada timeline -> ubah nama layer: tombol
profil.

Pada frame 40, klik kanan insert frame.

Selanjutnya pada frame 41 insert keyframe -> Pilih
menu File -> Insert to stage -> Pilih tombol yang telah
kita siapkan sebelumnya pada drive penyimpanan ->
Open. Posisikan tombol tersebut di bawah tombol
materi pelajaran. Atur ukuran objek W:100, H:100 dan
tambahkan teks di bawah objek, ketik tulisan 6. PROFIL
dengan ukuran font 15pt.

Selanjutnya kita akan menambahkan animasi perbesaran
tombol, Posisi cursor pada frame 45 -> insert keyframe.
Pada frame 41, perkecil objek dengan mengatur ukuran
objek dengan free transform tool (v) pada objek.
Kemudian posisikan cursor antara frame 41-45 -> klik
kanan pilih Create Classic Tween.

Pada frame 46 lakukan kembali insert keyframe dan pada
frame 50 insert frame, tampilan gambar seperti berikut:

Gambar 38. Animasi Tombaol Profil
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8. Posisikan cursor pada layer tombol profil dan pada posisi
frame 46, Pilih Menu Modify - Pilih Convert to symbol
atau tekan tombol F8 pada keyboard.

9. Berikan nama pada symbol: TProfil.

10. Pilih Type Button, Klik OK. TProfil dapat kita lihat pada
panel Edit Symbols. Objek telah berupa tombol.

11. Atur Properties button pada panel, isi <instance name>
dengan tombol_profil.

Bagian-bagian dari menu materi pelajaran telah kira rancang,

Selanjutnya kita akan menambahkan tombol exit dan notifikasi

keluar atau tidak dari menu dengan langkah-langkah berikut:

1. Add layer pada timeline -> ubah nama layer: exit.

2. Pada frame 45, klik kanan insert frame. Selanjutnya pada
frame 46 insert keyframe.

3. Pilih menu File -> Insert to stage -> Pilih tombol yang
telah kita siapkan sebelumnya pada drive penyimpanan
-> Open. Posisikan tombol tersebut di bawah kanan. Atur
ukuran objek W:50, H:50 dan tambahkan teks di bawah
objek, ketik tulisan Keluar dengan ukuran font 15pt.

4. Pada frame 50 insert frame, tampilan gambar seperti
berikut:

Gambar 39. Animasi Tombol Keluar
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Posisikan cursor pada layer tombol keluar dan pada posisi
frame 46, Pilih Menu Modify - Pilih Convert to symbol
atau tekan tombol F8 pada keyboard.

Berikan nama pada simbol: TExitl. Ketik tulisan:TExit1
karena kita akan menggunakan tombol yang sama pada
scene lainnya sehingga diberikan penamaan simbol yang
berbeda untuk memudahkan pembacaan program pada
sistem.

Pilih Type Button, Klik OK.
Atur Properties button pada panel, isi <instance name>

dengan tombol_exit. Instance name boleh sama pada
semua tombol exit

Merancang Notifikasi

Ketika menekan tombol keluar maka ada permberitahuan
(notifikasi) apakah kita yakin akan keluar dari menu atau tidak
dengan langkah-langkah sebagai berikut:

L.

Add layer pada timeline -> ubah nama layer: papan
notifikasi.

Pada frame 70, insert frame, Selanjutnya pada frame 61
-> insert keyframe.

Pilih rectangle Primitive Tool pada toolbox, atur ukuran
dengan X: 70, ¥:320, W: 340, H: 200 dengan stroke 6,20
dan rectangle options: 20. Warna papan sesuaikan. Seperti
gambar berikut:

Gambar 40. Papan Notifikasi
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10.
(i
12.

13.

Add layer pada timeline -> ubah nama layer: tombol ya
tidak.

Pada frame 60, insert frame, Selanjutnya pada frame 61
-> insert keyframe.

Pilih Text pada toolbox, ketik tulisan APAKAH ANDA
YAKIN UNTUK KELUAR atur posisi dan ukuran tulisan
serta warna yang cocok dengan warna background.

Selanjutnya menambahkan tombol ya dan tidak pada layer
yang sama.

Pilih menu File -> Insert to stage -> Pilih tombol yang
telah kita siapkan sebelumnya pada drive penyimpanan ->
Open. Atur posisi di bawah tulisan seperti gambar berikut:

Gambar 41. Tombol Ya Tidak

Posisikan cursor pada layer tombol ya dan pada posisi
frame 60, Pilih Menu Modify —> Pilih Convert to symbol
atau tekan tombol F8 pada keyboard.

Berikan nama pada symbol: TExitYa.

Pilih Type Button, Klik OK.

Atur Properties button pada panel, isi <instance name>
dengan yaexit. Instance name boleh sama pada semua
tombol exit.

Posisikan cursor pada layer tombol tidak dan pada posisi
frame 60, Pilih Menu Modify —> Pilih Convert to symbol
atau tekan tombol F8 pada keyboard.
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14. Berikan nama pada simbol: TExitTidak.
15. Pilih Type Button, Klik OK.

16. Atur Properties button pada panel, isi <instance name>
dengan tidak exit.

Kita telah merancang bagian-bagian dari scene menu utama. Pada

tampilan menu utama, kita akan bekerja dengan actionscript untuk
tombol Exit dan menu pilihan lainnya. Berikut actionscript (tekan
tombol F9) menu utama materi pelajaran:

1)

2)

3)

Layer Tombol Ya Tidak frame 60:

import flash.events.TouchEvent; import flash.
desktop.NativeApplication; stop():
Multitouch.inputMode=MultitouchInputMode.TOUCH_
POINT; vyaexit.addEventListener (TouchEvent.
TOUCH_ END, exitBAppl) ; function
exitAppl (event:TouchEvent) :void {
NativeApplication.nativeApplication.exit();

}

tidakexit.addEventListener (MouseEvent.CLICK,
exitl); function exitl (event:MouseEvent) :void{
gotoBAndPlay (45) ;

}

Layer Tombol Ya Tidak pada frame 59 (berikan insert keyframe
pada frame 59):

stop ()

Layer Actions frame 45 (tambahkan layer: actions, pada frame 45
insert keyframe):

import flash.events.MouseEvent; stop():

tombol_exit.addEventListener (MouseEvent.CLICK,
exit2); function exit2(event:MouseEvent) :void{

gotoBndPlay (60) ;

}

tombol pengguna.addEventListener (MouseEvent.
CLICK, pengguna);

function petunjuk(event:MouseEvent) :void{
gotoAndPlay (1, “petunjuk”) ;

}
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tombol kompetensi.addEventListener (MouseEvent.
CLICK, korputensi}:
function kowoe'ensi(
gctﬁL“dPlaW(l, kompetensi

tombol materi.addEventlistener (MouseEvent.CLICK,
r function materi (event:MouseEvent) :void{
a

JL"‘_I
(’D

tombol latihan.addEventListener (Mouse n
atihan); function latihan (event HOdSbL ent) :void{
AndPlay(1l,”latihan”);

i .addEventListener (MouseEvent.

nction referensi(event:MouseEvent):void{
1 n

tener (MouseEvent .CLICK,
event:MouseEvent) :void{

4) Layer Actions pada frame 70 (tambahkan insert keyframe pada
layer 70):
stop();
Ketika kita melakukan test movie (ctrl+enter) terdapat compile

errors yang berkaitan dengan actionscript, dapat kita cek pada bagian
compile errors seperti contoh pada gambar berikut:

Compiler Errors

Gambar 42. Compile Errors pada Actionscript
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Terdapat 8 errors pada AS scene kompetensi. Klik 2 kali pada bagian
yang error, maka akan tampil actionscript seperti gambar berikut:

impors flesh events MocseEwent;
cosbol exic.addEvencliscener (HouseEvenc.CLICK, exicld):

@ltunemion mxer evens iMoussETent)
gotainadPlay (50}
it |
sombol_home .addEvenclistener (HauseEvent .CLICK, home):
function home(event:MoussEvent) ivwoidf{
gotoAndPlay (45, "Homel")

)

Gambar 43 Actionscript

Pada line 3, terdapat skrip duplikat yaitu exit10, kita ubah menjadi
exit dengan angka belakangnya yang berbeda.

Actionscript diatas merupakan pemanggilan terhadap menu-menu
pilihan pada menu utama, gunakan kata yang berurutan saat penulisan
kode pada actionscript. Contoh:

tombol exit.addEventListener (MouseEvent.CLICK,

exi:lG;} function exitl0 (event:MouseEvent) :void{

gotoAndPlay (60) ;

Jika exit10 sudah digunakan, pada pendefinisian tombol_exit
selanjutnya gunakan exitll dan seterusnya, sama halnya dengan
pengkodean lainnya sehingga tidak terjadi duplikat kata pada AS. Untuk
uji scene yang telah dikerjakan gunakan ctrl+enter. Jika ada kesalahan
akan terlihat pada compile error, Klik layer pada compile error yang
salah, akan terdeteksi di mana kesalahan kode yang telah kita gunakan.
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Setelah itu lakukan penyimpanan dengan ctrl+s (save), lakukan
test movie kembali untuk mengecek compile errorsnya. Lakukan hingga
tidak terdapat lagi kesalahan skrip sehingga akan tampil test movie
terminted pada kolom output seperti gambar berikut:

Gambar 44. Informasi Output

Selanjutnya kita merancang halaman bagian dari menu utama
sebagai berikut:

1) Menu Petunjuk Pengguna

Atribut yang digunakan pada pembuatan menu petunjuk penggunaan
MPI adalah icon-icon/perintah-perintah dan teks sebagai informasi dari
icon-icon yang digunakan serta tombol-tombol yang diperlukan dalam
menu tersebut. Langkah-langkah dalam merancang petunjuk pengguna:
a. Menambahkan background
1. Buka edit scene —> Pilih scene Petunjuk, maka akan tampil
stage kosong yang akan kita rancang tampilan petunjuk
2. Posisikan cursor pada frame 1 pada timeline layer 1, ganti
nama layerl: backg
3. Import to stage —> Pilih background petunjuk —> klik open
Atur background pada stage dengan X: 0, Y: 0, W:480, H:800
pada properties
5. Posisikan cursor pada frame 60, Klik kanan insert frame.
b. Membuat Animasi pergerakan teks
1. Add layer, ubah nama layer: teks.

2. Padaframe 1 pilih text tool pada toolbox -> ketik “PETUNJUK
PENGGUNAAN?”, atur ukuran teks dan geser teks sebelah kiri
stage.

3. Padaframe 25 klik kanan insert keyframe, geser teks ke tengah

Pada frame antara 1-25, klik kanan Create Classic Tween.
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Membuat Animasi Perbesaran papan petunjuk

L.
2.

Add layer, ubah nama layer: papan petunjuk.

Pada frame 1 pilih rectangle tool pada toolbox -> atur ukuran
kotak dengan gunakan free transform tool (Q) dan posisi di
tengah stage.

Pada frame 5 klik kanan insert keyframe, geser kotak menjadi
lebih besar dari ukuran sebelumnya

Pada frame antara 1-5, klik kanan Create Classic Tween.

Lakukan Langkah 1 sampai 4 untuk membuat animasi
perbesaran sehingga membentuk kotak besar untuk memuat
isi profil. Lihat gambar timeline berikut:

Gambar 45. Timeline pada Menu Petunjuk Penggunaan

Selanjutnya kita akan menambahkan ikon home pada layer
dengan tahapan yang sama dengan kita membuat animasi
perubahan bentuk home pada scene home (lihat: Merancang
scene homel), namun pada scene home tidak terdapat
actionscript dan frame yang digunakan hanya sampai frame
60. Dapat juga kita copy paste ikon home dari scene homel
ke scene petunjuk penggunaan.

Setelah layer home kita tambahkan. Kita tambahkan juga layer
exit. Langkah-langkah penambahan layer exit sama dengan
layer exit pada scene homel, dapat juga kita copy paste
layer exit dari scene homel ke scene ini namun frame yang
digunakan hanya sampai frame 60.

Semua atribut pada scene ini telah kita tambahkan, selanjutnya
kita menambahkan layer actions, papan notif dan layer ya tidak
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dengan Langkah-langkah penambahan layernya sama dengan
layer actions, papan notif dan ya tidak pada scene homel1 (lihat:
merancang scene home).

Membuat scrollbar pada menu petunjuk pengguna:
Add New Layer->Ganti nama: isi

2. Buat kotak di dalam stage, Klik rectangle tool pada toolbox, beri
fill putih drag ke stage.

3. Posisikan cursor pada layer papan teks frame 20

4. Pilih menu window—>Pilih Component, kemudian Pilih Scrollpane
seperti gambar berikut:

Gambar 46. Tampilan User Interface

5. Kemudian drag ke papan teks yang telah kita buat seperti gambar
berikut:
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PETUNJUK PENGGUNAAN

Gambar 47. Tampilan Scrollpane

6. Membuat kotak teks dengan langkah-langkah berikut:
1. Posisi cursor pada layer papan teks frame 20, Pilih
rectangle tool, drag ke samping stage dengan ukuran sama
dengan stage seperti gambar berikut:

Gambar 48. Membuat Teks pada Scrollpane
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2. Tekan tombol F8 Convert to Symbol -> ganti nama:
petunjuk, type: movieclip dan centang actionscript linkage,
otomatis class dan base class terisi seperti gambar berikut:

Gambar 49. Actionscript Linkage

3. Selanjutnya hapus kotak teks tersebut dengan klik move
(v) -> delete.

4. Teks movieclip tersebut tidak hilang, akan tersimpan di
edit symbols.

5. Pilih Edit Symbols -> klik petunjuk, maka akan tampil
gambar berikut:
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Gambar 50. Symbol Movieclip

6. Perhatikan ujung kiri, berada pada posisi X:0, Y:0, dan
timeline untuk menambahkan layer.

7. Selanjutnya add new layer -> ganti nama isi teks, pilih
text tool pada toolbar, maka kita dapat menambahkan teks
pada movieclip petunjuk tersebut.

8. Masukan icon-icon dan teks ke dalam kotak terseburt,
seperti gambar berikut:

Gambar 51. Tampilan Isi Petunjuk Penggunaan
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9. Mengubah warna, ketik Q pada background warna, pilih
Fill Color pada toolbox, pilih warna yang sesuai dengan
kotak scrollbar.

10. Selanjutnya kita akan menghubungkan scrollbar dengan
movieclip petunjuk dengan Langkah-langkah sebagai
berikut:

a. Buka scene petunjuk -> klik scrollbar -> Pilh
Properties -> Pilih Property, maka akan tampil
bagian-bagian property.

Gambar 52. Tampilan Property

b. Isi source dengan nama movieclip: petunjuk.

11. Setelah selesai, kita akan menguji dengan test movie yaitu
tekan tombol ctrl+enter bersamaan, maka hasilnya seperti
gambar berikut:
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Gambar 53. Test Movie pada Scene

Catatan: Agar tulisan terbaca, hendaknya warna background
tidak menghalangi keterbacaan teks serta atur ukuran teks. Untuk
penggunaan scrollbar dapat kita gunakan pada pembuatan menu materi
pembelajaran dengan Langkah-langkah yang sama seperti diatas.

Actionscript pada menu petunjuk pengguna:

a) Layer Actions frame 45:
import flash.events.MouseEvent; tombol exit.
addEventListener (MouseEvent.CLICK, exitd); function
exit4 (event:MouseEvent) :void{ gotoAndPlay(50);

tombol home.addEventListener (MouseEvent.CLICK,
home2); function home?2 (event:MouseEvent) :void{

o L

gotoAndPlay (45, “Homel”) ;
}

b) Layer ya tidak frame 50:
import flash.events.TouchEvent; import flash.
desktop.NativeApplication; stop():;
Multitouch.inputMode = MultitouchInputMode.
TOUCH_POINT; yaexit.addEventListener (TouchEvent.
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TOUCH_END, exitApp3); function
exitApp3 (event:TouchEvent) :void ({

NativeApplication.nativeApplication.exit();

}

tidakexit.addEventListener (MouseEvent.CLICK,
exit5); function exit5(event:MouseEvent) :void{
gotoAndPlay (35) ;

}

¢) Layer Actions frame 60:
stop () ;

d) Layer ya tidak frame 49:
stop() ;

2) Menu Profil Guru

Pada MPI ini kita merancang scene yang lebih mudah terlebih dahulu
seperti scene profil guru karena tidak terlalu banyak layer yang
digunakan. Atribut yang digunakan pada pembuatan menu Profil
adalah Informasi tentang guru pengampu mata pelajaran serta tombol-
tombol yang diperlukan dalam menu tersebut Langkah-langkah dalam
merancang Menu Profil:
a. Background

1. Scene Profil telah kita siapkan sebelumnya

2. Klik Edit Scene —> Pilih Profil

3. Klik New layer pada timeline —> ganti nama layer: backg

4. Posisikan cursor pada frame 1 -> Import to stage background

profil

5. Pilih background profil dari folder -> Klik Open

6. Atur ukuran background sama dengan ukuran stage

7. Posisikan cursor pada frame 60 —> klik kanan insert frame.
b. Membuat Animasi pergerakan teks

5. Add layer, ubah nama layer: teks.

6. Pada frame 1 pilih text tool pada toolbox -> ketik “PROFIL
GURU?”, atur ukuran teks dan geser teks sebelah kiri stage.

Pada frame 25 klik kanan insert keyframe, geser teks ke tengah
Pada frame antara 1-25, klik kanan Create Classic Tween.
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¢. Membuat Animasi Perbesaran papan profil
9. Add layer, ubah nama layer: papan profil.

10. Pada frame 1 pilih rectangle tool pada toolbox -> atur ukuran
kotak dengan gunakan free transform tool (Q) dan posisi di
tengah stage.

11. Pada frame 5 klik kanan insert keyframe, geser kotak menjadi
lebih besar dari ukuran sebelumnya

12. Pada frame antara 1-5, klik kanan Create Classic Tiween.

13. Lakukan Langkah 1 sampai 4 untuk membuat animasi
perbesaran sehingga membentuk kotak besar untuk memuat
isi profil. Lihat gambar timeline berikut:

Gambar 54. Timeline Profil

d. Menambahkan teks isi profil
1. Add new layer -> ganti nama: isi profil

2. Klik text tool pada toolbox -> drag pada stage —> ketik Profil
Guru seperti gambar berikut:

PROFIL GURU

Gambar 55. Teks Isi Profil
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S

€.

Menambahkan Foto pada profil.
1. Add New Layer pada timeline — ubah nama layer: Foto

2. Pilih menu File —> pilih insert to stage —> pilih foto kita pada
folder —> Klik Open. Posisikan seperti gambar diatas.

Menambahkan layer exit pada scene profil dapat kita copy paste

dari scene menu utama.

Profil telah kita rancang, selanjutnya kita akan menambahkan

actionscript (tekan tombol F9 pada layer yang akan kita berikan AS)
pada scene profil sebagai berikut:

a)

d)

Layer tombol ya tidak pada frame 50:
import flash.events.TouchEvent;
import flash.desktop.NativeRpplicatien; stop();

Multitouch.inputMode = MultitouchInputMode.
TOUCH POINT; yaexit.addEventListener (TouchEvent.
TOUCH_END, exitApp?9); function
exitApp9 (event:TouchEvent) :void {

NativeBApplication.nativeBpplication.exit();

}

tidakexit.addEventlListener (MouseEvent.CLICK,
exit9); function exit9(event:MouseEvent) :void{
gotoAndPlay (35) ;

}

Layer tombol ya tidak pada frame 49:
stop ()

Layer Actions frame 45:

import flash.events.MouseEvent; tombol exit.
addEventListener (MouseEvent.CLICK, exitl0);
function exitl0O(event:MouseEvent) :void/{
gotoAndPlay(50) ;

}

tombol home.addEventListener (MouseEvent.CLICK,
home); function home(event:MouseEvent):void{
gotoAndPlay (45, “Homel”) ;

}
Layer Actions frame 60:
stop () ;
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3) Menu Kompetensi Dasar (KD)

Atribut yang digunakan pada pembuatan menu Kompetensi Dasar
adalah tabel Kompetensi Dasar dan Materi Pelajaran berupa teks sebagai
informasi dari Kompetensi Dasar yang digunakan serta tombol-tombol
yang diperlukan dalam menu tersebut. Kita dapat menduplikat scene
profil guru, agar kita tidak perlu lagi menambahkan beberapa layer
yang sama pada scene KD ini, sekali menduplikat dua tiga pekerjaan
terselesaikan dengan langkah-langkah sebagai berikut:

a.

Pilih menu Window -> Pilih scene, maka akan tampil gambar
berikut:

Scene

duplicate scene

delete scene

new scene

Gambar 56. Tampilan Semua Scene

Klik scene profil -> klik ikon duplicate scene, maka bertambah
scene duplikat profil: profil copy ->ganti nama: kompetensi.

Lihat scene kompetensi, menyerupai scene profil. Selanjutnya kita
akan mengubah beberapa layer yang disesuaikan dengan kebutuhan
dari scene kompetensi. Tampilan timeline seperti gambar berikut:

Gambar 57. Tampilan Timeline Scene KD
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d. Menggantikan teks profil dengan tabel kompetensi dasar dan materi
pelajaran dengan langkah-langkah sebagai berikut:

1) Buat tabel Kompetensi dasar seperti gambar berikut di aplikasi

pengolah teks dengan font size: 18, font style: cambria seperti

gambar berikut:
Kompetensi Dasar Materi Pembelajaran
3.1 Mengingdentifikasi ienis Jagu daerah| 3.1.1 Pengenalan ragam lagu/musi
sefempat daerah setempat
3.1.2 Elemenfunsur musik yang ada pad
lagu
3.2 Mepampilkan sikap iatiff 3.2.1Lagu daerah setempat.
terhadap keunikan lagu
setempat

Gambar 58. Tabel pada Aplikasi Pengolah Teks

2) Selanjutnya copy tabel tersebut, buka aplikasi animate,
posisikan cursor pada layer kompetensi dasar, paste tabel ke
tengah, kemudian atur posisi tabel seperti gambar berikut:

Gambar 59. Copy Paste Tabel pada Animate
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5)

6)

Ketika kita memindahkan tabel, otomatis tabel akan hilang,
kita dapat menambahkan garis tabel menggunakan Line Tool
pada toolbox, sehingga membentuk tabel. Garis tepi dapat
dihilangkan jika ada pertemuan antargaris, gunakan free
transform tool (Q) untuk menyeleksi garis yang berlebihan
kemudian hapus.

Pilih Line Tool -> drag ke atas tulisan kompetensi dasar dan
materi pelajaran dengan menekan tombol shift agar rata ->
drag dari kiri atas ke kanan atas.

Selanjutnya kita dapat menduplikat garis dengan posisi cursor
free transform dan tekan tombol D (duplicate) atur posisinya.
Untuk garis vertical dapat kita tambahkan dengan Langkah
yang sama dengan poin 4 sampai 5. Apabila merasakan kurang
rapi kita dapat membatalkan dengan tekan ctrl+z (Undo).
Tampilan tabel pada scene kompetensi sebagai berikut:

Gambar 60. Tampilan Tabel pada Scene Kompetensi Dasar
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1)

2)

3)

4)

7)

Berikut actionscript dari scene kompetensi dasar:
Layer tombol ya tidak pada frame 49:

stop();

Layer tombol ya tidak pada frame 50:

import flash.events.TouchEvent; import flash.
desktop.NativeApplication; stop();

Multitouch.inputMode = MultitouchInputMode.
TOUCH_POINT; yaexit.addEventListener (TouchEvent.
TOUCH_END, exitAppd) funetion
exitApp4 (event:TouchEvent) :void {

NativeBApplication.nativeBpplication.exit();

}
tidakexit.addEventListener (MouseEvent.CLICK,

exit8); function exit8(event:MouseEvent) :void({
gotoAndPlay(35);

}

Layer Actions frame 45:

import flash.events.MouseEvent; tombol exit.
addEventListener (MouseEvent.CLICK, exit7); function
exit7 (event:MouseEvent) :void{ gotoAndPlay (50);

}

tombol_home.addEventListener (MouseEvent.CLICK,
home3); function home3(event:MouseEvent) :void{
gotoAndPlay (45, “Homel”) ;

}
Layer Actions frame 60:

stop ()¢

Menu Materi Pembelajaran

Atribut yang digunakan pada pembuatan menu Materi Pembelajaran
adalah gambar dan teks sebagai informasi dari materi pembelajaran yang
digunakan serta tombol-tombol yang diperlukan dalam menu tersebut.

Pada pembahasan menu materi pembelajaran, kita akan merancang

menu dengan contoh satu materi pembelajaran yaitu seni musik,
karena actionscript setiap materi hampir sama, dengan merancang satu
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contoh materi akan memberi pemahaman kepada kita bagaimana cara
merancang menu materi pembelajaran. Kita akan merancang scene
materi seperti contoh berikut:

P

MATERI PELAJARAN

3 BEELATH VOUAL

Gambar 61. Bagian-bagian Scene Materi

Berikut Langkah-langkah dalam merancang menu materi

pembelajaran:

a. Pilih menu Window -> Pilih scene

b. Klik scene petunjuk penggunaan -> klik ikon duplicate scene, maka
bertambah scene duplikat petunjuk: petunjuk copy ->ganti nama:
materi.

c¢. Lihat scene materi, menyerupai scene petunjuk. Selanjutnya kita
akan mengubah beberapa layer yang disesuaikan dengan kebutuhan
dari scene materi antara lain tombol home, exit dan tombol ya
tidak. Jika kita tidak berkeinginan untuk menduplikat, kita dapat
melakukan tahapan merancang scene materi dari awal seperti kita
merancang scene petunjuk.

d. penggunaan. Berikut tampilan timeline:
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Gambar 62. Timeline Scene Materi

Membuat animasi teks bergerak pada judul materi dengan langkah-

langkah sebagai berikut:

a.

Pada layer judul frame 1 hapus semua frame dengan memblok dari
frame 1 sampai frame 60.

Pada frame 1 klik kanan insert keyframe -> Pilih text tool, ketik
tulisan Materi -> posisikan teks di samping stage.

Pada frame 20 klik kanan insert keyframe -> drag teks ke tengah.
Pada frame 21 klik kanan insert keyframe

Pada frame 60 klik kanan insert frame. Kita telah menyelesaikan
membuat animasi teks bergerak.

Membuat tombol submateri dan tombol video pembelajaran dengan

langkah-langkah sebagai berikut:

a.
b.

84

Add new layer -> Ganti nama materi.

Membuat tombol-tombol untuk tiga submateri dapat kita gunakan
langkah-langkah membuat tombol pada homel namun posisikan
cursor pada frame 1, semua tombol pada frame 1 karena kita tidak
membuat animasi perbesaran ketika ditampilkan. Adanya Animasi
perubahan bentuk pada saat tombol disentuh.

Lakukan convert to symbol untuk keempat tombol tersebut
dengan nama: Tmateril, Tmateri2, Tmateri3 dan Tvideo dan ubah
instance name pada properties dengan nama: tombol_materil,
tombol_materi2, tombol_materi3 dan tombol_video.

Selanjutnya kita membuat animasi perubahan bentuk dengan klik
2x pada tombol, ubah bentuk dengan langkah-langkah sama seperti
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kita membuat animasi perubahan bentuk pada tombol home dan
tombol exit.

Berikut actionscript dari scene materi:

Layer tombol ya tidak pada frame 49:

stop () ;

Layer tombol ya tidak pada frame 50:

import flash.events.TouchEvent; import £lash.
desktop.NativeApplication; stop();

Multitouch. inputMode -
MultitouchInputMode.TOUCH_POINT; yaexit.
addEventListener (TouchEvent.TOUCH_END, exitAppS5);
function exitAppS5 (event:TouchEvent) :void {
NativeApplication.nativeBpplication.exit();

}

tidakexit.addEventlistener (MouseEvent.CLICK,
exitl3); function exitl3(event:MouseEvent):void{
gotoBAndPlay(35);

}

Layer Actions frame 45:

import flash.events.MouseEvent; tombol_exit.
addEventListener (MouseEvent.CLICK, exitl2);
function exitl2(event:MouseEvent):void{
gotoAndPlay (50) ;

}

tombol materila.addEventlListener (MouseEvent.
CLICK,_ﬁaterila);

function materila(event:MouseEvent) :void{
gotoAndPlay (45, “materila”) ;

}

tombol home.addEventListener (MouseEvent.CLICK,
home4}? function homed (event:MouseEvent) :void{
gotoAndPlay (45, “Homel”) ;

}

tombol video.addEventListener (MouseEvent.CLICK,
videol?} function videol (event:MouseEvent) :void{
gotoRndPlay (45, “video”) ;

}
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4. Layer Actions frame 60:
stop();

Merancang scene materi la:
Kita akan merancang materi 1a dan timeline seperti gambar berikut:

BERNYANY] SECARA UNISONO

Gambar 63. Scene Materila

Gambar 64. Timeline Scene Materila

Melihat dari scene dan timeline materi 1a, tampilan yang akan
kita rancang sederhana, tidak berbeda dengan tampilan scene petunjuk
penggunaan (lihat: merancang scene petunjuk penggunaan). Layer
yang tidak digunakan dapat dihapus, teks materila dibuat ulang seperti
kita merancang scene materi (lihat: merancang scene materi). Namun
pada scene ini kita menambahkan tombol materi pembelajaran, back
dan next, dapat kita lakukan dengan Langkah-langkah sebagai berikut:
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Posisikan cursor pada layer materil frame 38 -> klik kanan insert
keyframe.

Pilih menu File -> Import to stage -> pilih tombol back dan next
yang telah kita siapkan -> open.

Selanjutnya atur ukuran dan posisi bawah kanan seperti gambar
diatas.

Tekan tombol F8 atau convert to symbol -> ganti nama: Tback pada
tombol back, Sedangkan pada tombol next ganti nama: Tnext.
Kita dapat menambahkan animasi perubahan warna pada tombol
back dan next, jika disentuh next maka akan berubah warna begitu
juga ketika kita menyentuh tombol back. Langkah-langkahnya sama
dengan membuat animasi perubahan bentuk pada tombol home
(lihat: merancang scene home).

Klik tombol next -> Isi instance name: tombol next pada
properties.

Klik tombol back -> isi instance name: tombol back pada
properties.

Kemudian kita menambahkan tombol materi (lihat scene homel
terdapat tombol materi)

Buka kembali scene homel, pilih layer tombol materi. Copy tombol
home yang berada pada frame 31.

Paste tombol materi pada scene materil pada layer materil tersebut,
atur posisi dan ukuran yang sesuai seperti gambar di atas (lihat:
gambar scene materila).

Kita pun dapat menduplikat symbol movieclip materi yang berisikan

teks dan gambar yang akan dihubungkan dengan scrollbar. Kita akan
menduplikat movieclip petunjuk, nantinya kita akan gantikan nama
duplikatnya dengan materila dengan langkah-langkah berikut:

a.

Pilih menu Window -> Pilih library (ctrl+L) -> akan tampil bagian
library atau

Pilih Library pada panels, jika library telah diletakan pada panels.
Selanjutnya pilih petunjuk, maka akan tampil pada layar (view)
isi petunjuk penggunaan yang telah kita rancang seperti gambar
berikut:
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Library

Gambar 65. Menduplikat Petunjuk

c. Lakukan duplikat dengan memilih ikon duplikat, maka akan
bertambah satu simbol movie clip: petunjuk copy -> ganti nama:
materila, maka akan bertambah movie clip baru dengan nama
materila.

d. Selanjutnya kita akan mengubah isi dari symbol, posisikan cursor
timeline, hapus tulisan pada layer 1 frame 1.

e. Ubah warna background yang sesuai, tambahkan kotak oval
dengan rectangle primitive tool, atur properties untuk membuat
kotak menjadi lengkung pada sudut-sudutnya. Seperti gambar
berikut:
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Mated elon Iformas Penduung

Gambar 66. Isi Materil pada Simbol Movieclip

f. Tambahkan teks yang sesuai dengan bagian materi yang harus
dituliskan. Batas baris hingga 1600.

g. Buka kembali scene materil -> pilih layer papan materil yang
terdapat scrollbar.

h. Isi source: materila pada property yang terdapat pada properties.

Pada scene materila tidak terdapat tombol exit karena materi 1
terdapat dua bagian yaitu materila dan materilb sehingga materi la
menggunakan tombol next untuk melanjutkan ke materi 1b.

Berikut actionscript scene materil:

1. Layer Actions frame 45:
import flash.events.MouseEvent; tombol next.
addEventListener (MouseEvent.CLICK, nextla);
function nextla(event:MouseEvent) :void{
gotoAndPlay (38, "materilb”);
}

i
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tombol_materi.addEventListene:{Mousezvent.CLICK,
materila3);

function materila3(event:MouseEvent):void/{
gotohkndPlay (45, "materi”);

}
2. Layer Actions frame 60:
stop () ;

Jangan lupa untuk selalu menyimpan data dan lakukan test movie
untuk melihat keberhasilan menjalankan movie tersebut. Jika terjadi
kesalahan cek kembali pada compile error untuk mengetahui di mana
letak kesalahannya.

Merancang scene materilb
Kita akan merancang scene materi 1b seperti gambar berikut:

BERNYANYI SECARA UNISONO

a"i l LEMBAR KERJA SISWA

Gambar 67. Tampilan Scene Materilb
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Gambar 68. Tampilan Timeline pada Scene Materilb

Perhatikan gambar tampilan scene materi 1b, hampir sama dengan
tampilan scene materi la, yang membedakan pada tombol lembar
kerja siswa saja. Langkah-langkah pengerjaannya dapat menggunakan
langkah-langkah merancang scene materi la, namun beberapa layer
disesuaikan dengan kebutuhan dari materi 1b antara lain:

1. Duplikat symbol movieclip materila menjadi materilb (lihat:
langkah-langkah menduplikat simbol movieclip materila).

2. Ubah isi source menjadi materilb sesuai dengan nama symbol.

Selanjutnya kita akan merancang tombol lembar kerja siswa (LKS).
LKS ini akan kita hubungkan dengan google drive sebagai penyimpanan
data sehingga membutuhkan akses internet untuk mengunduh LKS ini.
Langkah-langkah membuat tombol LKS sama dengan langkah-langkah
membuat tombol-tombol lainnya, namun yang membedakan terletak
pada actionsript yang digunakan karena terkoneksi jaringan internet.
Terlebih dahulu kita harus menyiapkan data di google drive dengan
langkah-langkah sebagai berikut:
1. Buka akun gmail yang kita miliki, Buka bagian aplikasi google di

samping akun google. Pilih drive -> Klik My Drive, maka akan

tampil gambar berikut:
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€ C @ drivegoogle.com/drivefu/0/my-drive

L Drive Q, Searchin Drive

My Drive -
| New
31 New folder
» @ My Drive
@ Upload files
g‘ Shared with me
(&) Upload folder
(© Recem
B Google Docs
Yr Stamed
Google Sheets
m Trash
Google Slides
More
E Storage

Gambar 69. Tampilan My Drive

2. Pilih upload file -> Open file yang telah kita siapkan -> Open,
maka file tersebut akan diproses seperti gambar berikut:

1 upload complete

Bl seni Musik_2.pdf Q

Gambar 70. File Terunduh

Maka file telah berhasil kita unduh.

Ketika kita mengklik tanda centang, tanda tersebut akan berubah
menjadi lokasi folder penyimpanan file tersebut. Selanjutnya klik
dua kali file tersebut, maka akan tampil gambar berikut:
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Gambar 71. Tampilan File pada Google Drive

Selanjutnya kita akan membagikan (share) file tersebut, Pilih Share
pada ikon tiga titik sebelah kanan atas seperti gambar berikut:

Manage comment notifications

B Jpen In New winoow
@ Report abuse

Gambar 72. Tampilan Share pada Google Drive
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6. Pilih Get link, maka akan tampil gambar berikut:

e Share with people and groups

No one has been added yel

© Getiink

hitps:i/drive_google comyfilerd/1 JsKCzwmu_pnacYe-2{NO_Fx2 ExkThSN/vi Copy link

Anyone with the link - i
® Anyona on the inlernet with this link can view

@ viewers of this file can see comments and suggestions
s

Gambar 73. Tampilan Get Link pada Google Drive

7. Pilih anyone with the link agar semua orang dapat mengunduh dan
melihat (viewer) tanpa harus meminta izin kepada pemilik akun.

8. Pilih copy link, maka link LKS tersebut telah kita simpan yang akan
kita masukan pada actionscript.

Berikut actionscript scene materilb:

1. Layer ya tidak frame 49:
stop ()’

2. Layer ya tidak frame 50
import flash.events.TouchEvent; import £flash.
desktop.NativeApplication; stop():
Multitouch.inputMode = MultitocuchInputMode.
TOUCH POINT; yaexit.addEventListener (TouchEvent.
TOUCH_END, exitApp6);
function exitAppb6{event:TouchEvent):void {
NativeApplication.nativeApplication.exit();

}
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tidakexit.addEventListener (MouseEvent.CLICK,
exitl5); function exitl5(event:MouseEvent):void{
gotoAndPlay(35) ;

}

3. Layer Actions frame 45: import flash.net. URLRequest; import flash.
events.MouseEvent;
tombol back.addEventListener (MouseEvent.CLICK,
backlb); function backlb(event:MouseEvent) :void{
gotoAndPlay (38, “materila”);
!
tombol materi.addEventListener (MouseEvent.CLICK,
materila2);

function materila2(event:MouseEvent):void/{
gotoAndPlay(l, “materi”) ;

}
tombol_lks.addEventListener (MouseEvent.CLICK,
unduhl); function unduhl (event:MouseEvent) :void

{

navigateToURL (new URLRequest (“https://drive.
google.com/file/d/XxxXxXXXXXXX/view

?Pusp=sharing”),” blank"”);
b
Catatan: Alamat link dapay kita isi dalam kurung antara tanda petik
dua (“) awal dan akhir.
4. Layer Actions frame 60:
stop ()

Kita telah merancang scene materi 1. Materi 2 dan 3 dapat kita
rancang dengan mengikuti Langkah-langkah yang sama dengan scene
materi 1 sesuaikan dengan kebutuhan dari materi 2 dan materi 3.

Menu Soal Latihan

Atribut yang digunakan pada pembuatan menu Soal Latihan adalah
halaman petunjuk pengerjaan soal, halaman soal-soal, halaman skor
nilai dan teks sebagai informasi dari Soal Latihan yang digunakan
serta tombol-tombol yang diperlukan dalam menu tersebut. kita akan
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menggunakan satu scene saja untuk menampilkan semua bagian yang
berkaitan dengan latihan soal. Langkah-langkah dalam merancang
menu Soal Latihan:

a)

b)
c)

d)

96

Buka scene soal latihan, kita akan mengimport background
petunjuk pengerjaan soal latihan. Pilih menu File -> Import to
stage, kemudian rapikan gambar background.

Posisikan cursor pada frame 35 pada layer, insert frame.

Kemudian kita menambahkan teks petunjuk pengerjaan soal dengan

langkah-langkah sebagai berikut:

« Klik add New layer - > Ganti nama new layer dengan nama:
petunjuk soal. Pada frame 9 insert keyframe, kemudian pada
frame 10 klik kanan insert blank keyframe karena layer ini
hanya ditampilkan pada awal saja.

Kemudian kita akan menambahkan tombol mulai untuk memulai

pengerjaan Latihan soal.

| CEEE——

LATIHAN SOAL

:1. Berdo'clah sebelum mulal mengerjakan Soal :
i2. Piinlah saloh satu jawaban yang paling tepat
i dengan meng-Kilk fombol jowaban A, B,C.
i D dan E podo fampilan yong fersedia H

g&ﬁmmmeMNmﬁmn

Gambar 74. Tampilan Pembuka Latihan Soal
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e)

g)

h)

)

Lakukan convert to symbol pada tombol mulai -> ganti
nama:Tmulai. Isi instance name: tombol_mulai. Pada frame 9 klik
kanan insert keyframe. Pada frame 10 klik insert blank keyframe.
Kita dapat memperhatikan timeline berikut:

oy =t
ny A
% =
m.
M to
L, |

-

L N
L |

"y

Gambar 75. Timeline pada Scene Latihan

Selanjutnya kita menambahkan layer pilihan ganda -> add new layer
-> pada frame 1 insert keyframe -> pada layer 11 insert keyframe.
Pada layer 11 kita akan menambahkan tombol-tombol pilihan ganda
-> Pilih menu File -> Import to stage -> Open file tombol-tombol
pilihan ganda (A, B, ¢, dan D) yang telah kita siapkan. Atur posisi
dan ukuran tombol pada stage.

Kemudian tombol-tombol tersebut dijadikan simbol -> blok tombol
A -> Convert to symbol -> ganti nama: tA -> isi instance name:
teAl pada properties. Lakukan hal yang sama pada tombol B, C
dan D. Lakukan animasi perubahan warna, ketika tombol disentuh
akan berubah warna (lihat langkah-langkah merancang materi)

Tambahkan isi pilihan gandanya pada layer pilihan ganda

Selanjutnya kita menambahkan layer pertanyaan. seperti gambar
berikut:

Bab 2 --- Proses Pembuatan Media Pembelajaran Interaktif 97



k)

98

Gambar 76. Tampilan Soal

Penambahan soal 2 dapat kita lakukan tanpa harus membuat ulang
-> Posisikan cursor pada frame 12 pada layer pilihan ganda dan
pertanyaan dengan cara diblok -> klik kanan insert keyframe, maka
otomatis akan tercopy -> ubah pertanyaan dan isi pilihan gandanya.
Lakukan penambahan soal 3 sampai dengan 10 dengan langkah-
langkah pada poin k.

Penambahan layer-layer lainnya telah kita bahas secara detail pada
scene-scene sebelumnya.

Setelah 10 soal ditampilkan selanjutnya kita merancang slide skor
nilai-> Posisikan cursor pada layer pilihan ganda frame 21-> pilih
text tool pada toolbox -> drag ke stage, atur posisi dan ukurannya
seperti gambar berikut:
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Q)

SKOR TOTAL

———

KELUAR

Gambar 77. Tampilan Skor Nilai

Selanjutnya kita akan merancang kolom skor yang berisi angka
jumlah jawaban yang benar -> Posisikan cursor pada layer pilihan
ganda frame 21-> pilih text tool pada toolbox -> drag ke stage,
atur posisi dan ukurannya.

Buka properties -> ubah tipe teks: dynamic text -> isi instance
name: Hevaluasi -> ubah anti alias pada character: use device fonts
-> ubah paragraph di behavior: multiline (agar bisa menampung
angka lebih dari dua digit).

Jangan lupa untuk selalu menyimpan setiap saat dan meng-compile
untuk mengecek kesalahan pada skrip.

Berikut actionscript pada scene latihan:
Layer Actions frame 1:

import flash. events.MouseEvent; tombol _
mulai. addEventListener (MouseEvent. CLICK, fl1
ClickToGoToAndStOpAtFrame_sz} ;

function ﬂ_ClickToGoToAndStOpAtE‘ramedBS(event:Mo
useEvent) :void
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gotoAndStop(11);
}
Layer Actions frame 11:
var sel:int;
var se2:int;
var se3:int;
var sed:int;
var seb:int;
var se6:int;
var se7:int;
var seB:int;
var se9:int;
var selO:int;
var steva:int=0;

teAl.addEventListener(MouseEvent.CLICK, £l _
ClickToGoToNextFrame_ll);

function ﬂ_ClickToGoToNextFrameqll(event:MouseEv
ent) :void
{

sel=10

nextFrame () ;

teBl.addEventListener(MouseEvent.CLICK, f1_
ClickToGoToNextFrame_12);

function ﬂ_ClickToGoToNextFrame_l2(event:MouseEv
ent) :void

{
sel=0;
nextFrame () ;
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teCl.addEventListener (MouseEvent.CLICK, £E.
ClickToGoToNextFrame 13);

function fl ClickToGoToNextFrame 13 (event:MouseEv
ent) ;void
{

sel=0;

nextFrame () ;

teDl.addEventListener (MouseEvent.CLICK, £1_
ClickToGoToNextFrame 14);

function fl ClickToGoToNextFrame 14 (event:MouseEv
ent) :void

{
sel=0;
nextFrame();

}

Layer Actions frame 12:

teA2.addEventListener (MouseEvent.CLICK, £l
ClickToGoToNextFrame 16);

function il ClickToGoToNextFrame 16 (event:MouseEv
ent) :void

{
5e2=10;

nextFrame () ;

teB2.addEventListener (MouseEvent.CLICK, f£f1
ClickToGoToNextFrame_ 17);

function fl ClickToGoToNextFrame 17 (event:MouseEv
ent) :void

{
s522=0;

nextFrame () ;
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teC2.addEventListener (MouseEvent.CLICK, f£fl1_
ClickToGoToNextFrame 18);

function fl ClickToGoToNextFrame_ 18 (event:MouseEv
ent) :void
{

se2=0;

nextFrame () ;

teD2.addEventListener (MouseEvent.CLICK, fl1_
ClickToGoToNextFrame 19);

function fl ClickToGoToNextFrame 19 (event:MouseEv
ent) :void
{
se2=0;
nextFrame () ;
}
Layer Actions frame 13:

teA3.addEventListener (MouseEvent.CLICK, £f1_
ClickToGoToNextFrame 21);

function fl ClickToGoToNextFrame 21 (event:MouseEv
ent) :void
{

se3=10;

nextFrame () ;

teB3.addEventListener (MouseEvent.CLICK, £l _
ClickToGoToNextFrame 22);

function ﬂ_ClickToGoToNextFrame_22(event:MouseEv
ent) :void
{

se3=0;

nextFrame () ;




teC3.addEventListener (MouseEvent.CLICK, i,
ClickToGoToNextFrame 23);

function fl ClickToGoToNextFrame 23 (event:MouseEv
ent) :void

{
se3=0;

nextFrame() ;

teD3.addEventListener (MouseEvent.CLICK, f1
ClickToGoToNextFrame 24);

function fl ClickToGoToNextFrame 24 (event:MouseEv
ent) :void

{
se3=0;
nextFrame () ;

}

Layer Actions pada frame 14:

teAd . .addEventListener (MouseEvent.CLICK, £f1_
ClickToGoToNextFrame 26);

function fl ClickToGoToNextFrame 26 (event:MouseEv
ent) :void
{

se4=10;

nextFrame () ;

teB4.addEventListener (MouseEvent .CLICK, £fl1_
ClickToGoToNextFrame 27);

function fl ClickToGoToNextFrame 27 (event:MouseEvV
ent) :void
{

sed=0;

nextFrame() ;
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teC4.addEventListener (MouseEvent.CLICK, f1_
ClickToGoToNextFrame 28);

function fl ClickToGoToNextFrame 28 (event:MouseEv
ent) :void

{
sed=10;

nextFrame();

teD4.addEventListener (MouseEvent.CLICK, fl1_
ClickToGoToNextFrame_29);

function fl ClickToGoToNextFrame 29 (event:MouseEv
ent) :void

{
sed=0;
nextFrame();

}

Layer Actions pada frame 15:

teAS5.addEventListener (MouseEvent.CLICK, £fl1_
ClickToGoToNextFrame_ 31);

function fl ClickToGoToNextFrame 31 (event:MouseEv
ent) :void

{
se5=10;

nextFrame () ;

teB5.addEventListener (MouseEvent.CLICK, £1_
ClickToGoToNextFrame 32);

function fl ClickToGoToNextFrame 32 (event:MouseEv
ent) :void
{

se5=0;

nextFrame () ;
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teC5.addEventListener (MouseEvent.CLICK, £l
ClickToGoToNextFrame 33);

function ﬂ;ClickToGoToNextFrame_33(event:MouseEv
ent) :void

{
se5=0;
nextFrame() ;

teD5.addEventlListener (MouseEvent.CLICK, £f1_
ClickToGoToNextFrame 34);

function fl ClickToGoToNextFrame 34 (event:MouseEv
ent) :void
{

seb=0;

nextFrame() ;

}

Layer Actions frame 16:

teA6.addEventListener (MouseEvent.CLICK, £f1
ClickToGoToNextFrame_36) ;
function fl ClickToGoToNextFrame 36 (event:MouseEv
ent) :void
{

se6=10;

nextFrame () ;

teB6.addEventListener (MouseEvent.CLICK, f1
ClickToGoToNextFrame 37);

function fl ClickToGoToNextFrame 37 (event:MouseEv
ent) :void
{

seb6=0;

nextFrame() ;
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teC6.addEventListener (MouseEvent.CLICK, f1
ClickToGoToNextFrame 38);

function fl ClickToGoToNextFrame 38 (event:MouseEv
ent) :void
{

se6=0;

nextFrame () ;

teD6.addEventListener (MouseEvent.CLICK, £f1 _
ClickToGoToNextFrame_39) ;

function fl ClickToGoToNextFrame 39 (event:MouseEv
ent) :void
{
se6=0;
nextFrame () ;
}
Layer actions frame 17:

teA7.addEventlistener (MouseEvent.CLICK, £l _
ClickToGoToNextFrame 41);

function fl ClickToGoToNextFrame 41 (event:MouseEv
ent) :void
{

se7=10;

nextFrame();

teB7.addEventlistener (MouseEvent.CLICK, f1_
ClickToGoToNextFrame 42);

function fl ClickToGoToNextFrame 42 (event:MouseEv
ent) :void
{

se7=0;

nextFrame () ;
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teC7.addEventListener (MouseEvent.CLICK, £l
ClickToGoToNextFrame 43);

function fl ClickToGoToNextFrame 43 (event:MouseEv
ent) :void

{
seT7=0;

nextFrame() ;

teD7.addEventListener (MouseEvent.CLICK, £l _
ClickToGoToNextFrame 44);

function fl ClickToGoToNextFrame 44 (event:MouseEv
ent) :void
{
seT=0;
nextFrame () ;
}
Layer actions frame 18:

teA8.addEventListener (MouseEvent.CLICK, £1_
ClickToGoToNextFrame 46);

function ﬂ;ClickToGoToNextFrame_46(event:MouseEv
ent) :void
{
seB=10;
nextFrame () ;
1

teB8.addEventListener (MouseEvent.CLICK, fl1_
ClickToGoToNextFrame 47);

function fl ClickToGoToNextFrame 47 (event:MouseEv
ent) :void

{
se8=0;

nextFrame() ;
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10.

teC8.addEventListener (MouseEvent.CLICK, fl1
ClickToGoToNextFrame 48);

function fl ClickToGoToNextFrame 48 (event:MouseEv
ent) :void
{

seB=0;

nextFrame () ;

teD8.addEventlistener (MouseEvent.CLICK, fl
ClickToGoToNextFrame 49); -
function fl ClickToGoToNextFrame 49 (event:MouseEv
ent) :void - B
{

sef=1;

nextFrame () ;
}
Layer actions frame 19:

teA9.addEventListener (MouseEvent.CLICK, f£f1_
ClickToGoToNextFrame 51);

function fl ClickToGoToNextFrame 51 (event:MouseEv
ent) :void
{

5e9=10;

nextFrame () ;

teB9.addEventListener (MouseEvent.CLICK, fl
ClickToGoToNextFrame_52);

function fl ClickToGoToNextFrame 52 (event:MouseEv
ent) :void

{
se9=0;
nextFrame () ;
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teC9.addEventListener (MouseEvent.CLICK, £1
ClickToGoToNextFrame 53);

function fl ClickToGoToNextFrame 53 (event:MouseEv
ent) :void

{
s5e9=0;
nextFrame() ;

teDY.addEventListener (MouseEvent.CLICK, EL
ClickToGoToNextFrame 54);

function fl ClickToGoToNextFrame 54 (event:MouseEv
ent) :void

{
se9=0
nextFrame () ;

}

Layer actions frame 20:

teAl0.addEventListener (MouseEvent.CLICK, £l _
ClickToGoToNextFrame_ 106) ;

function fl ClickToGoTcNextFrame 106 (event:MouseE
vent) :void

{
sel0=10;

steva=sel+se2+se3+sed+seb+seb+seT+seB+sed+
sell; nextFrame();

teBl0.addEventListener (MouseEvent .CLICK, f1_
ClickToGoToNextFrame 107) ;

function ﬂ;plickToGoToNextFrame_lO7(event:MouseE
vent) :void

{
sel0=0;
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steva=sel+sel2+se3+sed+seS+seb+seT+seB+s5e0+
sel0; nextFrame();

teCl0.addEventlistener (MouseEvent.CLICK, £l _
ClickToGoToNextFrame 108);
function fl ClickToGoToNextFrame 108 (event:MouseE
vent) :void
{
sel0=0;
steva=sel+se2+se3+sed+tseb+seb+seT+seB8+se9+
sel0; nextFrame();

teD10.addEventListener (MouseEvent.CLICK, fl
ClickToGoToNextFrame 109); -
function fl ClickToGoToNextFrame 109 (event:MouseE
vent}:void_ -
{
sel0=0;
steva=sel+se2+se3+sed+seS+seb+seT+seB+sed+
sel0; nextFrame();

}

12. Layer actions frame 21:
import flash.events.MouseEvent; Hevaluasi.
text=steva.toString():

tombol_home.addEventListener{MouseEvent.CLICK,
homel0); function homelQ (event:MouseEvent) :void{

gotoAndPlay (35, “Homel”) ;
}

tombol exit.addEventListener (MouseEvent.CLICK,
exith5); function exitbb(event:MouseEvent) :void

{

gotoAndPlay (22) ;




13.

14.

15.

Layer stop frame 10 sampai dengan layer 21:
stop () ;

Layer tombol ya tidak frame 21:

stop () ;

Layer tombol ya tidak frame 22:
import flash.events.TouchEvent; import flash.
desktop.NativeApplication; stop();

Multitouch.inputMode = MultitouchInputMode.
TOUCH PQINT; yaexit.addEventListener (TouchEvent.
TOUCH END, exitAppl4);

function exitAppld (event:TouchEvent):void {
NativeApplication.nativeApplication.exit();

}

tidakexit.addEventListener (MouseEvent.CLICK,
exitld); function exitld (event:MouseEvent):void{
gotofndPlay(1l1);

}

Menu Referensi

Atribut yang digunakan pada pembuatan menu Referensi adalah
Informasi daftar pustaka serta tombol-tombol yaitu menu modul online
dan evaluasi online yang diperlukan dalam menu tersebut. Langkah-
langkah dalam merancang Menu Referensi:

1)

Merancang Menu Utama Referensi

Pada menu utama referensi kita akan meletakkan daftar Pustaka dan
tombol-tombol dari Modul online, Evaluasi Online, Video tutorial dan
Forum Diskusi, Tombol Home serta Tombol Exit dengan Langkah-
langkah berikut:

1)

2)
3)
4

Pilih menu File — Import file to stage, Pilih file image background
referensi

Klik Open, atur image pada stage.
Posisikan cursor pada frame 50 Klik insert frame.

Selanjutnya kita akan menambahkan teks daftar Pustaka. Klik New
layer, pada scene referensi, ganti nama layer “teks”.
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5) Posisikan cursor pada frame 1.

6) Pilih text tool pada toolbox, drag ke stage —> ketik Judul Daftar
Pustaka, isi daftar Pustaka seperti gambar berikut:

7) Tekan tombol T pada teks, blok tulisan, atur Font Style dan Font
Size pada properties teks.

8) Background dan daftar pustaka telah kita rancang, selanjutnya kita
akan merancang submenu modul online seperti gambar berikut:

| REFERENSI

DAFTAR FUSTARA

Gambar 78. Tampilan Scene Referensi

|
i

il

Gambar 79. Timeline Scene Referensi
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2)

Merancang Submenu Modul Online

Pada MPI ini, untuk materi inti kita jabarkan pada materi pembelajaran,
sedangkan materi pembelajaran secara keseluruhan yang berisikan materi
kognitif dan psikomotorik beserta contoh-contoh yang lebih banyak
serta soal Latihan pada setiap KD kita jabarkan pada modul. Modul yang
kita rancang tidak tersimpan di MP], hal ini untuk mengurangi kapasitas
penyimpanan pada MPI sehingga kita rancang modul online. Modul
online adalah modul yang ditampilkan memerlukan akses internet,
dapat kita simpan di smartphone dengan cara mengunduhnya. Modul
online akan kita rancang dengan menggunakan Animate.

10.

11.

Langkah-langkah membuat tombol modul online sebagai berikut:
Klik New layer pada scene referensi, ganti nama

“modul”.

Posisikan cursor pada frame 1

Pilih menu File — Import to stage - Pilih tombol modul yang telah
kita siapkan.

Posisikan image tombol modul di bawah kiri teks daftar Pustaka
seperti gambar berikut:

Kita akan membuat tombol menjadi simbol, tekan tombol F8 atau
Pilih menu Modify — Convert to symbol.

Isi Name: tmbl_modul, Isi type: Button.

Buka advanced, klik tulisan advanced, maka akan tampil gambar
berikut:

Klik Ok

Selanjutnya kita membuat tombol akan berubah menggunakan
hover seperti tombol home.

Ikuti Langkah-langkah seperti tombol homel untuk membuat
tombol modul akan berubah ukuran Ketika akan di klik.

Karena kita akan menjadikan modul online, sehingga kita harus
membuat link pada button tersebut. Siapkan file modul yang telah
memiliki link. Salah satu penyimpanan data modul dapat di simpan
pada google drive.
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12. Langkah-langkah menyimpan file modul pada google drive:

a. Buka email -> Pilih menu google drive pada menu google
apps, Pilih Drive, maka akan tampil My Drive.

b. Pilih upload file, pilih file modul yang telah kita siapkan, klik
Ok

¢. Selesai proses upload file selesai, selanjutnya kita akan
membuat link yang dapat kita masukan ke dalam actionscript
modul, dengan cara: Klik share drives, pilih link kemudian
save link tersebut.

3) Merancang Submenu Evaluasi Online

Evaluasi Online yaitu evaluasi yang dirancang memerlukan akses
internet. Aplikasi yang kita gunakan dalam perancangan evaluasi
online adalah form google doc. Pada pembahasan sebelumnya tentang
mengenal form google docs, kita telah membahas form yang standar
digunakan dalam dunia pendidikan, jadi pada pembahasan ini kita akan
langsung pada Langkah-langkah membuat form evaluasi online berikut:

1)

7)

114

Siapkan terlebih dahulu butir-butir soal baik berupa teks, gambar,
audio, video, dan animasi yang berkaitan dengan soal-soal yang
akan kita buat pada form google docs.

Buka email kita, kemudian klik Google apps pada panel kanan atas
seperti kita membuka google drive pada pembahasan sebelumnya
seperti gambar berikut:

Pilih docs, selanjutnya akan tampil pilihan template form.

Pilih Blank Quiz, contoh: Ketik dengan judul Ujian Akhir Semester
dan add folder sebagai tempat penyimpanan data di google drive.
maka tampil gambar berikut:

Klik tulisan Blank Quiz isi dengan Evaluasi Akhir/Ulangan Akhir
Semester dan sebagainya yang dapat kita sesuaikan.

Klik tulisan Form Description isi dengan deksripsi pembelajaran
contoh: Materi Pembelajaran Teknik Animasi 2 dan 3 Dimensi
Semester Ganjil TP 20../20...

Kita dapat menambahkan Nama Siswa dengan klik Untitiled
Question —> Pilih Short Answer, maka tampil gambar berikut:
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8)

9

10)

11)

1)
2)

3)

4)

Geser tombol Required (wajib diisi) ke kanan, agar pertanyaan
tersebut wajib diisi, jika tidak diisi, system akan meminta diisi.
Tambahkan alamat email untuk mengirim umpan balik jawaban
nantinya dengan klik Kembali add question pada menu samping
seperti gambar berikut:

Tambahkan password/token pada section ini dengan Langkah-

langkah berikut:

1) Klik add question —> pilih short answer

2) Geser tombol required (wajib diisi) ke kanan

3) Klik titik tiga disamping required, pilih validation responds,
maka akan tampil gambar berikut:

4) Selanjutnya Pilih Text, jika kita ingin password atau token
berbentuk tulisan, isi password disamping text tersebut contoh
SENIMUSIK7, maka text tersebut telah menjadi password/
token soal ujian online.

5) Klik Save, kemudian klik preview untuk ujicoba. Maka akan
tampil gambar berikut:

Jika password/token yang kita isi salah maka tidak dapat

melanjutkan ke pengerjaan soal ujian.

Kita dapat melihat hasilnya dengan klik preview dengan icon mata,

akan tampil gambar berikut:

Selanjutnya kita masuk pada pertanyaan soal:

Klik tulisan add section

Isi Untitled Section, contoh: Silakan jawab pertanyaan berikut
dengan tepat.

Tambahkan add question - Isi Question dengan soal pertama,
contoh: Untuk membuat ilustrasi gambar burung seperti gambar
berikut, maka tool yang tepat adalah menggunakan....

Jika pada pertanyaan tersebut terdapat gambar, kita dapat
memasukan gambar/video dengan mengklik add image (ikon
picture)/add video yang terletak disamping tulisan pertanyaan.
Pilih salah satu pilihan pada insert image yaitu upload (ambil
gambar yang tersimpan di PC/Laptop)/Camera (gambar langsung
diambil dari webcam yang terpasang pada PC/Laptop)/By URL
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6)

7)

8)
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(ambil gambar dari browsing internet)/Google drive (gambar yang
tersimpan pada google drive)/google image search (mencari gambar
dari browser google).

Selanjutnya klik browse atau dapat langsung kita drag file dari
folder file yang telah kita siapkan. Kita pilih browse dari folder,
pilih file - Klik Open, maka tampil gambar berikut:

Kita dapat mengecilkan atau membesarkan gambar tersebut dengan
mengklik gambar akan tampil garis kotak biru, Tarik garis tersebut

Selanjutnya kita mengisi pilihan gandanya, jika ada 5 pilihan dapat
kita lakukan Langkah-langkah sebagai berikut:

a)

b)

)

d)

e)

g

Klik tulisan option 1, isi dengan pilihan pertama contoh:
selection, pilihan abjad a, b, ¢, d dan e tidak perlu kita ketikan,
karena google form akan otomatis mengacak pilihan. Pada
pilihan tersebut dapat kita tambahkan image/gambar.

Isi pilihan selanjutnya dengan klik add other hingga akhir
pilihan atau dapat kita copas semua pilihan ganda yang telah
kita siapkan, paste pada option, hapuskan pilihan abjadnya
tesebut maka akan tampil gambar berikut:

Jika terjadi kesalahan atau ada bagian yang kosong, dapat
kita hapus dengan mengklik tanda x pada bagian yang tidak
kita butuhkan. Kita telah menyelesaikan pengetikan soal dan
pilihan seperti gambar berikut:

Selanjutnya kita akan menambahkan kunci jawaban, klik
Answer Key, kita diminta untuk mengisi poin nilai dari
pertanyaan, seperti gambar berikut:

Pada bagian bawah pilihan ganda ada pilihan menambahkan
umpan balik jawaban, yang digunakan untuk memberikan
jawaban yang benar, atau memberikan motivasi jika jawaban
yang dijawab salah, klik Add answer feedback seperti gambar
berikut:

Pada bagian incorrect answers Isi komentar atau motivasi
ketika jawaban salah contoh: Jawaban Anda Salah, Silakan
Pelajari lagi dan tetap semangat.

Pada bagian Correct answers contoh: Jawaban Anda benar,
Tingkatkan prestasi belajar anda.
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10)

h)

i)
j)
k)

Kita dapat menambahkan link pada bagian add link,dapat juga
kita menambahkan pencarian video pada youtube atau alamat
URL namun bersifat optional. Selanjutnya Save add feedback
tersebut, maka tampil gambar berikut:

Klik Done, maka penambahan umpan balik jawaban selesai.
Pada bagian Required dapat kita aktifkan.

Kita dapat menambahkan ceklis pada shuffle option order yang
terletak di samping tulisan Required dengan mengklik tanda
tiga titik. Shuffle option order untuk memberikan pilihan
jawaban secara acak.

Lanjutkan pada soal berikutnya. Untuk melihat hasilnya dapat kita
klik preview kembali.

Form yang kita buat dapat kita ujicobakan untuk melihat tingkat
keberhasilan kita dalam membuat soal ulangan dengan Langkah-
langkah sebagai berikut:

a)

b)

e)

f)

Klik Send ~> maka tampil gambar berikut:
Gambar tampilan

Ada beberapa pilihan untuk mengirim form yaitu via email/
link/embed HTML, dapat juga via facebook atau twitter.

Kita menggunakan link yang dapat kita share pada siswa
melalui sosial media grup. Maka kita klik via link, copy link
tersebut

Kemudian ceklis Automatically collect respondent’s
SMK Negeri 1 Pangkalpinang email address.

Klik shorten URL agar URL tidak terlalu panjang contoh:
https://forms.gle/xxxxxxx8

Klik tombol Copy. Maka akan tersimpan form pada clipboard.

Form telah kita selesaikan, selanjutnya kita dapat share link untuk
ujicoba form yang kita gunakan dengan membagikan link tersebut.
Respondens pada form berguna untuk melihat berapa banyak responden
yang mengerjakan soal. Data respondes tersimpan di speedsheet pada
google drive. Spreedsheet tersebut dapat kita simpan pada PC/Laptop
apabila semua responden telah mengerjakan evaluasi tersebut, seperti
gambar berikut:
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Selain itu kita dapat menganalisis tingkat kesulitan butir soal yang

telah kita sajikan dengan melihat grafik dari yang telah dikerjakan oleh
responden seperti gambar berikut:

Form untuk evaluasi online telah kita selesaikan selanjutnya

kita akan menghubungkan link form tersebut pada Animate dengan
Langkah-langkah berikut:

1)

2)

3)

4)
5)
6)
7)
8)
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Kita akan membuat button evaluasi online pada scene reference
dengan Langkah-langkah yang sama dengan membuat tombol
modul online yang telah kita bahas sebelumnya.

Tambahkan layer pada scene reference, klik add layer
~  ganti nama layer evaluasi
Ubah image evaluasi menjadi button, tekan tombol F8

- Convert to Symbol

Ganti Name: tmbl_evaluasi, Ceklis button

Klik Advances seperti gambar berikut:

[si seperti gambar di atas.

Tekan tombol OK

Selanjutnya klik 2 kali button evaluasi, kita akan menggunakan
perubahan tombol Ketika diklik, lakukan Langkah-langkah yang
sama dengan membuat tombol modul online yang telah kita bahas
sebelumnya.

Berikut Actionscript scene referensi:
1. Layer ya tidak frame 49:
stop();

2. Layer ya tidak frame 50:

import flash.events.TouchEvent; import ilash.
desktop.NativeApplication; stop():

Multitouch.inputMode = MultitouchInputMode.
TOUCH POINT;

yaexit.addEventListener (TouchEvent.
TOUCH END, exitApp8) ; function
exitApp8 (event:TouchEvent) :void {
NativeBRpplication.nativelpplication.exit();

}
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tidakexit.addEventListener (MouseEvent.CLICK,
exitl9); function exitl9(event:MouseEvent) :void{
gotoAndPlay(35);

}

3. Layer Actions frame 45:
import flash.events.MouseEvent; tombol exit.
addEventListener (MouseEvent.CLICK, exitl8);
function exitl8(event:MouseEvent):void{
gotoAndPlay(50);
}
tombol home.addEventListener (MouseEvent.CLICK,
homelQ); function homel0 (event:MouseEvent) :void{
gotoAndPlay (45, "Homel”) ;
}
tombol_modul.addEventListener (MouseEvent.
CL TCK; anduh ) ; fanetion
unduh?2 (event :MouseEvent) :void
{
navigateToURL (new URLRequest (“https://drive.
google.com/file/d/xxxxx”),” _blank”);
}
tombol evaluasi.addEventListener (MouseEvent.
CLICK, unduh3);
function unduh3(event:MouseEvent) :void
{
navigateToURL(new URLRequest (“https://drive.
google.com/file/d/xxxxxx"”),” blank”)
}

4. Layer Actions frame 60:
stop ()

9) Menambahkan actionscript pada layer evaluasi dengan Langkah-
langkah berikut:
a) Posisikan cursor pada frame 1, tekan tombol F9, maka akan

b)

tampil gambar actionscript berikut:

Pilih scene reference —> Pilih layer Evaluasi frame 1,
actionscript berikut:
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import flash.net.URLRequest; import flash.events.
MouseEvent;

tmbl__evaluasil .addEventlListener (MouseEvent.
CLICK, unduh2);

function unduh? (event:MouseEvent) :void
{

navigateToURL (new URLRequest (“http:// “),”_
blank”);

}

Mempublikasikan MPI untuk Android

Kita telah melakukan perancangan MPI secara keseluruhan. Selanjutnya
kita akan melakukan publikasi MPI yang telah dirancang dari format fla
(default Animate) menjadi apk. Pada tahap ini kita akan menjelaskan
langkah-langkah untuk mengeksport MPI default menjadi ekstensi apk
yang nantinya akan disesuaikan dengan versi smartphone yang akan
dgunakan untuk mengoperasikan MPI pada android dengan Langkah-
langkah sebagai berikut:

1) Pilih menu File -> Pilih AIR 20.0 For Android Settings, maka akan

tampil gambar berikut:

= _,-ﬂ.':';-,.,_.l £ o

Gambar 80. tampilan AIR For Android Setting
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2) Kita harus menentukan output File terlebih dahulu -> Klik tanda
folder pada bagian output untuk memilih tujuan penyimpanan
(Select File Destination) -> isi nama: Seni Budaya -> Save as Type:
Android App File (*.apk) -> save.

3) Sebelum kita mengisi menu general, klik menu development untuk
pengisian sertificate seperti gambar berikut:

— -

T e
Cotnte: | (NIRRT | bwe. | Coe. |
T Rementer s for P scsmee
vt depieyre tex
B Do v

[y rap—
Odebne
Pt et o ronse dabLGGRG:
st
AR e
| imead AT Anmnt s aekoane
Gt e s ol Py |
AP ptorng
| i e o T ZvecEd AOTS ST

| Launen amoscan on on the rprerind e deane

Anter

o] cmn | nem [

Gambar 81. Menu Deployment

a) Pada bagian certificate klik create, maka akan tampil gambar
berikut:

mnﬂtlﬂ years

Save as:  ExfPeroan - I

I S =

Gambar 82. Tampilan Certificate
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b)

c)
d)

e)

g

h)

)

k)

m)

Isi publisher nama file yang kita kerjakan, contoh:

Irdhan Publisher

Organization Unit dapat diisi dengan nama pribadi kita atau

organisasi impian kita, contoh: Idrhan Corp dan sebagainya.

Organization name dapat juga diisi dengan nama organisasi

atau nama yang sama dengan Organization Unit.

Country: IN (Indonesia), optional karena tidak memberikan

pengaruh besar terhadap produk.

Password: berikan password yang mudah kita ingat seperti

12345678.

Confirm password dari password yang telah kita isi dengan

password yang sama.

Type: 1024-RSA.

Validaty Period: masa untuk validasi produk dapat kita isi

tahun yang lebih lama contoh: 25 years

Save as: tentukan tempat penyimpanan produk pada

penyimpanan file-file produk, agar memudahkan kita mencari

saat diperlukan.

Selanjutnya Tekan tombol OK, maka certificate telah dibuat.

Sebelum kita mempublish, kita harus meletakan icon

pada menu icon yang akan menjadi icon produk MPI pada

smartphone

Pilih menu icons, maka akan tampil gambar berikut:

a) Ada beberapa pilihan, pilih ukuran icon 48x48

b) Tekan menu browse disamping 36x36, maka akan masuk
pada data penyimpanan, pilih icon yang telah kita siapkan,
Klik OK. Maka akan tampil preview seperti gambar
berikut:
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Gambar 83. Preview Icon

4) Kemudian pilih menu permissions, pilih Internet karena kita akan

menggunakan internet untuk unduh modul dan sebagainya.

5) Selanjutnya buka development Kembali, mengisi bagian
development seperti gambar berikut:

Cthan: | DR Rt X DO | B, | Ot
i sassasses
| Rt smseer by the sre=
radond Geghrmment type
W Dt
Laipin rpeee
i Deng
Partean poiacs for oo denaErs:
Twtmt
AR
G M e e s Py

Ao iy
| e s st o e corwschs denchd devc

Lo st o e e i drees

e T .|

Gambar 84. Tampilan Deployment
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a) Bagian certificate telah terisi pada saat kita membuat create

b) Password: isi dengan password yang telah kita buat.

¢) Android development type: Klik Emulator Release karena
kita membutuhkan emulator dari Adobe AIR Emulator, dapat
diperoleh dari laman situs Adobe AIR.

d) Unduh versi Adobe AIR 25.0 agar dapat digunakan untuk
smartphone tipe android versi froyo ke atas.

e) AIR Runtime: Pilih Get AIR runtime from: Google Android
Market, walaupun google android tidak menyediakan lagi
namun kita bisa mengunduh dari lama adobe AIR.

f) Kosongkan after publishing.

6) Selanjutnya kita menuju menu general — maka otomatis data-data
yang telah kita isi pada menu development telah mengisi menu
general seperti gambar berikut:

7) Isiversion: 1.0.0 karena merupakan versi pertama yang belum ada
revisi.

8) Kosongkan version label

9) Aspect Ratio: Auto, karena versi android auto bisa portrait ataupun
landscape.

10) Centang Full screen

11) Render Mode: CPU

12) Included File: ada video yang kita gunakan pada produk maka klik
tanda + pilih video yang tempat penyimpanan data selanjutnya
pilih tipe swf video yang telah kita gunakan pada produk contoh:
SkinOverAll.swf.
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Gambar 85. General pada AIR for Android Settings

13) Semua telah kita kerjakan selanjutnya kita akan mempublish AIR
For Android tersebut dengan klik Publish, maka akan dilakukan
proses publish dalam beberapa waktu.

14) Jika publish berhasil, menyatakan apk telah berhasil dibuat maka
akan tampil gambar berikut:

15) Buka File penyimpanan data MPI, maka akan tampil icon dengan
ekstensi penyimpanan apk seperti gambar berikut:

Gambar 86. lkon Apk

16) Maka kita telah berhasil menyimpan file dalam bentuk penyimpanan
apk.
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d.

Mengoperasikan Apk pada Smartphone

Selanjutnya kita akan mengoperasikan apk pada smartphone dengan
Langkah-langkah berikut:

1)
2)

3)

4)

6)
7)

8)
9)

Buka File penyimpanan apk.

Ada 2 apk yang harus kita pindahkan yaitu apk Adobe AIR versi
25.0 dan apk produk MPI

File tersebut dapat kita simpan pada google drive/Compact Disk/
USB Animate ataupun mengirim apk melalui bluetooth. Jika kita
ingin menyimpan pada USB Animate tentukan kita harus memiliki
OTG USB.

Pindahkan kedua apk tersebut ke smartphone. Selanjutnya install
terlebih dahulu apk Adobe AIR pada smarphone, setelah itu kita
menginstal apk produk dengan Langkah-langkah berikut:

Setelah instal apk maka akan tampil tahapan install apk. Tampil
pemberitahuan Blocked to Play Protect, maka Pilih Install Anyway,
seperti gambar berikut:

Selanjutnya akan tampil Send app for scanning, pilih don’t send,
tunggu loading hingga tampil proses penginstalan, klik open
Apk akan terinstal, maka akan tampil icon pada tampilan layar
smartphone.

Klik tombol aplikasi

Setelah aplikasi terbuka, akan tampil tampilan awal pembuka
Animasi 2 Dimensi dan halaman judul setelah pembuka.

10) Maka aplikasi sudah dapat kita jalankan pada smartphone.
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Tahap pascaproduksi merupakan tahap evaluasi produk, apakah
MPI yang telah dibuat sesuai dengan tujuan-tujuan yang telah ditetapkan
pada tahap praproduksi yang berupa unsur pemahaman, aplikasi dan
analisis. Sebelum produk MPI digunakan oleh pengguna (end-user)/
siswa, maka perlu dilakukan evaluasi produk. Evaluasi produk dengan
menggunakan instrumen penilaian berdasarkan kriteria. Tahap ini akan
menjelaskan secara detail beberapa tahap pengujian produk pada tahap
pascaproduksi antara lain:

A. Pengujian Perangkat Lunak

Pengujian perangkat lunak digunakan untuk melihat kelebihan dan
kekurangan dari aplikasi MPI yang telah kita rancang, perlu adanya
penilaian atau validasi atas MPI. Validasi dilakukan oleh para ahli yaitu
ahli media, ahli materi dan ahli bahasa, untuk melihat apakah MPI yang
kita rancang layak untuk digunakan dalam pembelajaran. Penilaian
ini berguna untuk memperbaiki MPI apakah perlu adanya perbaikan
sehingga MPI layak digunakan.
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